Installation Guide for SAP S/4HANA 1709
Content

1 Getting Started .................................................... 5
2 SAP S/4HANA System Landscape Information ........................................ 6
3 Installation Documentation ....................................................... 8
4 Product Information ............................................................ 11
5 Maintenance Planner ........................................................... 15
6 Installation Process ............................................................ 16
7 Installation Follow-Up Activities ...................................................... 17
   7.1 Importing Data to SAP S/4HANA ........................................... 17
       SAP S/4HANA Migration Cockpit ....................................... 17
       SAP Data Services ......................................................... 19
   7.2 System Configuration for SAP S/4HANA .............................................. 19
   7.3 User Assistance Settings ........................................................ 20
       Enable User Assistance for the Back-End System .................. 20
       Enable Context-Sensitive User Assistance for SAP Fiori Launchpad ........................................ 22
   7.4 Follow-Up Activities for Advanced Variant Configuration .................. 26
   7.5 Follow-Up Activities for Analytics .............................................. 27
   7.6 Installation of SAP Fiori .......................................................... 27
   7.7 Installation of the PI Adapters for Elster and Swift ...................... 27
   7.8 Creating RFC Destinations for liveCache Applications ................ 28
   7.9 Follow Up Activities in Master Data Governance ...................... 29
   7.10 Follow-Up Activities for Environment, Health, and Safety .......... 30
   7.11 Follow-Up Activities for Enterprise Portfolio and Project Management ........................................ 31
       Follow-Up Activities for SAP Portfolio and Project Management ........................................ 31
       Follow-Up Activities for Commercial Project Management ........ 32
   7.12 Follow-Up Activities for Product Safety and Stewardship ............ 42
       Follow-Up Activities for Product Compliance ........................................ 42
       Follow-Up Activities for Product Safety and Stewardship for Process Industries ........................................ 43
   7.13 Follow-Up Activities for Supplier and Category Management ........ 43
   7.14 Follow-Up Activities for Human Resources (Compatibility Packs) ........................................ 44
       Integration in SAP S/4HANA .............................................. 44
       Integration Scenarios ........................................................ 45
       Conversion from SAP ERP to SAP S/4HANA .......................... 57
       Employee-Business Partner Synchronization ........................................ 61
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>FAQ</td>
<td>68</td>
</tr>
<tr>
<td>Related Notes</td>
<td>68</td>
</tr>
<tr>
<td>7.15 Follow-Up Activities for the SAP S/4HANA Financial Closing cockpit</td>
<td>68</td>
</tr>
<tr>
<td>Setting Up the BI Content</td>
<td>69</td>
</tr>
<tr>
<td>7.16 Troubleshooting</td>
<td>71</td>
</tr>
</tbody>
</table>
# Document History

Table 1:

<table>
<thead>
<tr>
<th>Version</th>
<th>Date</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.0</td>
<td>September 15, 2017</td>
<td>First published version.</td>
</tr>
</tbody>
</table>
1 Getting Started

This guide provides you with the following information about SAP S/4HANA:

- A system landscape and product overview
- A list of the tools and documentation you need for the installation
- Important follow-up activities you need to consider after the installation

**Note**

This guide cannot be used on its own, you need to use it together with the installation guides describing the installation of SAP Application Server Systems Based on SAP NetWeaver using the Software Provisioning Manager 1.0 tool.

You find these guides (as well as a link to the SPM tool) on the SAP Support Portal at [https://support.sap.com/sitoolset](https://support.sap.com/sitoolset) > System Provisioning > Installation Option > Installation Guides - Application Server Systems > SAP Application Server Systems Based on SAP NetWeaver.

These installation guides are sorted by database, technology (ABAP and Java), and SAP NetWeaver product release. For the installation of SAP S/4HANA, choose the SAP HANA Database guide for your operating system (UNIX, IBM, or Windows) and SAP NetWeaver 7.X-based.
There are various ways of deploying SAP S/4HANA in your new or already existing system landscape. This section describes some examples.

**Example: SAP S/4HANA New Installation**

A new installation of SAP S/4HANA needs to run on the SAP HANA database. It is recommended to use the SAP Solution Manager, which can run on any database. This very simple landscape can be enhanced with the SAP cloud solutions and SAP Business Suite products.

![Diagram of Simple SAP S/4HANA Deployment](image)

**Example: SAP S/4HANA in an SAP Business Suite Landscape**

It is possible to integrate SAP S/4HANA into an existing SAP Business Suite landscape by replacing the SAP ERP enhancement package product with SAP S/4HANA. When performing this conversion in your system landscape,
you need to do some adaptations, for example you need to convert some of your existing business processes to the simplified SAP S/4HANA processes. Some of the SAP Business Suite processes are no longer supported, some have been changed, and there are also new processes. How to convert your existing processes to the SAP S/4HANA processes is described in the *Simplification List*.


---

**Figure 2: Example SAP Business Suite landscape with an embedded SAP S/4HANA system**

### More Information

For more information about SAP Fiori for SAP S/4HANA in a hub deployment, see *Landscape Deployment Recommendations for SAP Fiori Front-End Server*. 
### 3 Installation Documentation

#### Table 2: SAP S/4HANA 1709 Required Installation Documentation

<table>
<thead>
<tr>
<th>Documents</th>
<th>Comments and Links</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Installation Guide for SAP S/4HANA 1709 (this guide)</strong></td>
<td>This document contains information relevant for the installation of SAP S/4HANA, but it does not describe the process or the installation tool. They are described in the Software Provisioning Manager guides listed below.</td>
</tr>
</tbody>
</table>

Installation guides describing the installation of SAP systems based on SAP NetWeaver 7.1 and higher using the Software Provisioning Manager 1.0 which is part of SL Toolset 1.0. Make sure that you always use the latest SP version of the tool and guides available on the SAP Support Portal at [http://help.sap.com/sltoolset](http://help.sap.com/sltoolset).

These installation guides are sorted by database technology. For the installation of SAP S/4HANA, choose the SAP HANA Database guide for your operating system (UNIX, IBM, or Windows) in the ABAP and Java technology versions.

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Database</td>
<td>Select your database</td>
</tr>
<tr>
<td>Product Release</td>
<td><strong>SAP NetWeaver 7.X-based</strong></td>
</tr>
<tr>
<td>Operating System Platform</td>
<td>Select your OS</td>
</tr>
<tr>
<td>Technical Stack</td>
<td>ABAP and JAVA</td>
</tr>
</tbody>
</table>
You need the SAP HANA Server Installation and Update Guide for the installation of the following components:

- **SAP LiveCache on SAP HANA**
  If you plan to use the SAP S/4HANA Production Planning & Detailed Scheduling (PP/DS) application, it is important that you install HANA integrated liveCache, which is the HANA component SAP LCA (also called LCAPPS- or liveCache Applications plugin).

- **VCH AFL (SAP VCH AFL FOR SAP HANA 1.00)**
  See also SAP Note 1898497.

**Note**
For each SAP HANA revision, there exists one corresponding version of these SAP HANA system components.

You find this guide on the SAP Help Portal at http://help.sap.com/hana_platform/Installation and Upgrade/SAP HANA Server Installation and Update Guide. For information about how to install or update these components, see the section Managing SAP HANA System Components in the guide.

<table>
<thead>
<tr>
<th>Documents</th>
<th>Comments and Links</th>
</tr>
</thead>
<tbody>
<tr>
<td>SAP HANA Server Installation and Update Guide</td>
<td>You need the SAP HANA Server Installation and Update Guide for the installation of the following components:</td>
</tr>
<tr>
<td></td>
<td>• SAP LiveCache on SAP HANA</td>
</tr>
<tr>
<td></td>
<td>If you plan to use the SAP S/4HANA Production Planning &amp; Detailed Scheduling (PP/DS) application, it is important that you install HANA integrated liveCache, which is the HANA component SAP LCA (also called LCAPPS- or liveCache Applications plugin).</td>
</tr>
<tr>
<td></td>
<td>• VCH AFL (SAP VCH AFL FOR SAP HANA 1.00)</td>
</tr>
<tr>
<td></td>
<td>See also SAP Note 1898497.</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong></td>
</tr>
<tr>
<td></td>
<td>For each SAP HANA revision, there exists one corresponding version of these SAP HANA system components.</td>
</tr>
<tr>
<td>SAP S/4HANA 1709: Release Information Note</td>
<td>SAP Note 2482453.</td>
</tr>
<tr>
<td>SAP S/4HANA 1709: Restriction Note</td>
<td>SAP Note 2491467.</td>
</tr>
<tr>
<td>SAP FIORI for SAP S/4HANA 1709: Release Information Note</td>
<td>SAP Note 2482461.</td>
</tr>
<tr>
<td>SAP S/4HANA Add-on Note</td>
<td>SAP Note 2214409.</td>
</tr>
</tbody>
</table>

**Table 4: Additional Documentation**

<table>
<thead>
<tr>
<th>Documents</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Documents</td>
<td>Comments</td>
</tr>
<tr>
<td>--------------------------------------------------------------------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>System copy guides describing the system copy of SAP systems based on SAP NetWeaver 7.1 and higher using the Software Provisioning Manager 1.0 which is part of SL Toolset 1.0.</td>
<td>You find these guides on the SAP Help Portal at <a href="https://support.sap.com/sltoolset">https://support.sap.com/sltoolset</a> &gt; System Provisioning &gt; System Copy Option &gt; Guide for Systems Based on SAP NetWeaver 7.1 and Higher</td>
</tr>
</tbody>
</table>
4 Product Information

This section gives an overview of the components of SAP S/4HANA 1709.

Table 5: SAP S/4HANA Components

<table>
<thead>
<tr>
<th>Component Name</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>SAP S/4HANA Server</td>
<td>Based on SAP NetWeaver 7.52 for SAP S/4HANA 1709; SAP S/4HANA back-end system</td>
</tr>
<tr>
<td>SAP Predictive Integrator</td>
<td>SAP PREDICTIVE INTEGRATOR 1 - HANA Content</td>
</tr>
<tr>
<td>SAP HANA Rules Framework</td>
<td>HANA RULES FRAMEWORK 1.0</td>
</tr>
<tr>
<td>SAP S/4HANA AFL</td>
<td>SAP VCH AFL FOR SAP HANA 1.00</td>
</tr>
<tr>
<td>SAP LiveCache on SAP HANA</td>
<td>SAP HANA LCAPPS 1.00</td>
</tr>
<tr>
<td>SAP Optimizer</td>
<td>SAP SCM Optimizer 13.0</td>
</tr>
<tr>
<td>Integration for Elster</td>
<td>• Elster 2.1</td>
</tr>
<tr>
<td></td>
<td>• NW 7.52 for S/4HANA 1709 - Advanced Adapter Engine Extnd</td>
</tr>
<tr>
<td></td>
<td>• UTESTER 730</td>
</tr>
<tr>
<td>Integration for Swift</td>
<td>• NW 7.52 for S/4HANA 1709 - Advanced Adapter Engine Extnd</td>
</tr>
<tr>
<td></td>
<td>• SWIFT 622</td>
</tr>
<tr>
<td></td>
<td>• UTSWIFT 730</td>
</tr>
<tr>
<td>ESR Content</td>
<td>SAP S/4HANA 1709 ESR Content (XI CONTENT)</td>
</tr>
<tr>
<td>SAP EHS Expert Server</td>
<td>EH&amp;S EXPERT 3.2</td>
</tr>
<tr>
<td>SAP EHS WWI Server</td>
<td>EH&amp;S WWI 3.2</td>
</tr>
</tbody>
</table>

i Note

SAP S/4HANA 1709 is based on SAP NetWeaver 7.52; but Elster and Swift can run on SAP NetWeaver 7.3 EHP1 and higher releases.
<table>
<thead>
<tr>
<th>Component Name</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Application Server ABAP</td>
<td>• SAP ABA 7.5C</td>
</tr>
<tr>
<td></td>
<td>• SAP BASIS 7.52</td>
</tr>
<tr>
<td></td>
<td>• SAP BW 7.52</td>
</tr>
<tr>
<td></td>
<td>• SAP HOST AGENT 7.21</td>
</tr>
<tr>
<td></td>
<td>• SAP IGS 7.45</td>
</tr>
<tr>
<td></td>
<td>• SAP IGS HELPER</td>
</tr>
<tr>
<td></td>
<td>• SAP KERNEL 7.53 64-BIT UNICODE</td>
</tr>
<tr>
<td></td>
<td>• SAP NW GATEWAY FOUNDATION 7.52</td>
</tr>
<tr>
<td></td>
<td>• ST-PI 740</td>
</tr>
<tr>
<td></td>
<td>• USER INTERFACE TECHNOLOGY 7.52</td>
</tr>
<tr>
<td>Basis Apps</td>
<td>• NW 7.52 FOR S/4HANA 1709 - Application Server ABAP</td>
</tr>
<tr>
<td></td>
<td>• UI FOR BASIS APPLICATIONS 300</td>
</tr>
<tr>
<td>Business Intelligence</td>
<td>• NW 7.52 FOR S/4HANA 1709 - Application Server ABAP</td>
</tr>
<tr>
<td></td>
<td>• SAP NW 7.40 BI CONT ADDON 7.57</td>
</tr>
<tr>
<td>BI Content Extension</td>
<td>• NW 7.52 FOR S/4HANA 1709 - Application Server ABAP</td>
</tr>
<tr>
<td></td>
<td>• BI CONT EXT FOR BI CONT 7.57</td>
</tr>
<tr>
<td>Adobe Document Services</td>
<td>• ADOBE DOCUMENT SERVICES 7.50</td>
</tr>
<tr>
<td></td>
<td>• NW 7.52 FOR S/4HANA 1709 - Application Server ABAP</td>
</tr>
<tr>
<td>Enterprise Services Repository</td>
<td>• ESR 7.50</td>
</tr>
<tr>
<td></td>
<td>• NW 7.52 FOR S/4HANA 1709 - SAP S/4HANA Java</td>
</tr>
<tr>
<td></td>
<td>• PI GUI LIBRARY 7.50</td>
</tr>
<tr>
<td></td>
<td>• XI CONTENT SAP_BASIS 7.50</td>
</tr>
<tr>
<td>ESR Content</td>
<td>XI CONTENT SAP_ABA 75C</td>
</tr>
<tr>
<td>Advanced Adapter Engine Extnd</td>
<td></td>
</tr>
<tr>
<td>Content Server</td>
<td>SAP CONTENT SERVER 6.50</td>
</tr>
<tr>
<td>Frontend</td>
<td>• ADOBE LIFECYCLE DESIGNER 11.0</td>
</tr>
<tr>
<td></td>
<td>• SAP BUSINESS CLIENT 6.5</td>
</tr>
<tr>
<td></td>
<td>• SAP GUI FOR JAVA 7.50</td>
</tr>
<tr>
<td></td>
<td>• SAP GUI FOR WINDOWS 7.50 CORE</td>
</tr>
<tr>
<td></td>
<td>• SAP SCREENREADER EXTENSIONS</td>
</tr>
<tr>
<td>ABAP in Eclipse</td>
<td></td>
</tr>
<tr>
<td>Component Name</td>
<td>Comment</td>
</tr>
<tr>
<td>---------------------------------</td>
<td>----------------------------------</td>
</tr>
<tr>
<td>SAP Web Dispatcher</td>
<td>SAP WEB DISPATCHER 7.53</td>
</tr>
<tr>
<td>SAPUI5 Dev Toolkit: IDE Plugins</td>
<td>SAPUI5 TEAM PROV IDE 3.00</td>
</tr>
</tbody>
</table>

Table 7: SAP Fiori for SAP S/4HANA 1709

<table>
<thead>
<tr>
<th>Component Name</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>SAP Fiori UIs can be installed as addons to the SAP S/4HANA back end or, in a hub installation, on the SAP NetWeaver AS for ABAP 7.52 for SAP S/4HANA 1709 standalone front-end server.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Component Name</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>UI for SAP S/4HANA</td>
<td>• UIAPFI70 500</td>
</tr>
<tr>
<td></td>
<td>• UIS4HOP1 300</td>
</tr>
<tr>
<td></td>
<td>• UIX01CA1 200</td>
</tr>
<tr>
<td>UI for Approve Requests</td>
<td>UIX01CA1 200</td>
</tr>
<tr>
<td>UI for HCM (Human Capital Management)</td>
<td>• UIHRO01100</td>
</tr>
<tr>
<td></td>
<td>• UIX01CA1 200</td>
</tr>
<tr>
<td>UI for new HCM</td>
<td>• UIHRO02 100</td>
</tr>
<tr>
<td></td>
<td>• UIX01CA1 200</td>
</tr>
<tr>
<td>UI for MDG (Master Data Governance)</td>
<td>UIMDG001 200</td>
</tr>
<tr>
<td>Backend for Approve Requests</td>
<td>SAP IW PGW 100 (Process Gateway)</td>
</tr>
<tr>
<td>UI for TVR</td>
<td>• UITRV001 200</td>
</tr>
<tr>
<td></td>
<td>• UIX01CA1 200</td>
</tr>
</tbody>
</table>

Table 8: SAP Multichannel Foundation for Utilities and Public Sector, UI add-on for SAP S/4HANA 1709

<table>
<thead>
<tr>
<th>Component Name</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>MCF UI</td>
<td>UIS4MCF 100</td>
</tr>
</tbody>
</table>

Table 9: SAP S/4HANA foundation 1709

<table>
<thead>
<tr>
<th>Component Name</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>MDG FOUNDATION 802</td>
<td>MDG FOUNDATION 751</td>
</tr>
<tr>
<td>NW 7.52 FOR S/4HANA 1709</td>
<td>SAP S/4HANA 1709 - Application Server ABAP</td>
</tr>
</tbody>
</table>
Component Name | Comment
--- | ---
S4FND 102 | ● EPHOX CORP - TINYMCE 4.3.12
 | ● jQuery - jQuery/jquery 2.2.3
 | ● jQuery Calendars 2.0.0

Table 10: Databases for SAP S/4HANA

<table>
<thead>
<tr>
<th>Database</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>SAP HANA (supported product versions SAP HANA DATABASE 1.0 and SAP HANA DATABASE 2.0)</td>
<td>Used as back-end database for SAP S/4HANA; can also be used by SAP Fiori for SAP S/4HANA in an embedded and in a hub deployment. When configuring your SAP S/4HANA installation package through Software Provisioning Manager (SWPM), you get a screen named Configuration of SAP liveCache with SAP HANA. Here, choose to install liveCache for SAP System. ● For SAP S/4HANA you can only choose the SAP HANA integrated liveCache. ● You need the liveCache installation only when at least one of your applications use it. ● Client 000 is not a production client.</td>
</tr>
<tr>
<td>SAP MaxDB (product version MAXDB 7.9 64-BIT)</td>
<td>The SAP Fiori front-end can run on SAP MaxDB and SAP ASE in a hub deployment, but the back-end database for SAP S/4HANA must be the SAP HANA database. For more information about SAP Fiori for SAP S/4HANA in a hub deployment, see Landscape Deployment Recommendations for SAP Fiori Front-End Server</td>
</tr>
<tr>
<td>SAP Adaptive Server Enterprise (SAP ASE) (product version SAP ASE 16.0 FOR BUS. SUITE)</td>
<td></td>
</tr>
</tbody>
</table>

**Note**

Databases other than the three mentioned in the table above are **not supported** for SAP S/4HANA.
5  Maintenance Planner

We recommend that you use the Maintenance Planner to plan your installation. The Maintenance Planner creates a stack XML file with the support package stack information that you then hand over to the Software Provisioning Manager (the installer).

**Note**

The Maintenance Optimizer (MOPZ) cannot be used with SAP S/4HANA. It has been replaced by the Maintenance Planner.

6 Installation Process

The installation process for SAP S/4HANA and its components is described in the Software Provisioning tool guides referenced in the section Installation Documentation [page 8].
7 Installation Follow-Up Activities

i Note

We recommend to use the ABAP Task Manager for Lifecycle Management Automation for the initial configuration of SAP NetWeaver-based systems.

For more information, see http://help.sap.com/s4hana_op_1709_001 \[ SAP NetWeaver for SAP S/4HANA \[ Technical Operations for SAP NetWeaver \[ Solution Life Cycle Management \[ SAP NetWeaver Configuration \[ ]

7.1 Importing Data to SAP S/4HANA

The following sections explain possible ways of migrating data to SAP S/4HANA:

- SAP S/4HANA Migration Cockpit [page 17]
- SAP Data Services [page 19]

7.1.1 SAP S/4HANA Migration Cockpit

For the migration of legacy data to SAP S/4HANA, SAP provides the SAP S/4HANA migration cockpit. It helps you to transfer your master data and business data from SAP systems and non-SAP systems to SAP S/4HANA 1610 and 1709. The cockpit is included in the SAP S/4HANA license and embedded in the SAP S/4HANA shipment.

For the data migration, the migration cockpit uses predefined migration content, for example, standard migration objects such as customer, supplier or purchase order objects, to identify and transfer the relevant data. Templates and mappings for each migration object support the migration.

The migration cockpit also allows you to integrate your custom data into the migration using the migration object modeler. For example, you can adjust the predefined standard migration objects delivered with the cockpit by adding fields to them. As of SAP S/4HANA 1610 FPS02, you can also create your own custom-specific migration objects or SAP standard objects that have not yet been included in the scope of the migration cockpit.

You can use the migration cockpit by calling transaction LTMC. To use the migration cockpit, you need the role SAP_CA_DMC_MC_USER.

To access the migration object modeler, you use transaction LTMM. A prerequisite for using the modeler is that you have created a migration project in the migration cockpit and that the role SAP_CA_DMC_MC_DEVELOPER is assigned to your user.
<table>
<thead>
<tr>
<th>Migration Objects</th>
<th>Maintenance Plan</th>
</tr>
</thead>
<tbody>
<tr>
<td>Accounts Payable (Vendor Open Item)</td>
<td></td>
</tr>
<tr>
<td>Accounts Receivable (Customer Open Item)</td>
<td></td>
</tr>
<tr>
<td>Activity Price</td>
<td>Master Inspection Characteristic</td>
</tr>
<tr>
<td>Activity Type</td>
<td>Material* (incl. Long Text)</td>
</tr>
<tr>
<td>Bank Master Data</td>
<td>Material Inspection Type</td>
</tr>
<tr>
<td>Batches</td>
<td>Material Commodity Code</td>
</tr>
<tr>
<td>Bill of Material</td>
<td>Material Consumption</td>
</tr>
<tr>
<td>Characteristic</td>
<td>Material Classification</td>
</tr>
<tr>
<td>Class</td>
<td>Material Price Change</td>
</tr>
<tr>
<td>Code / Code Group</td>
<td>Pricing Condition</td>
</tr>
<tr>
<td>Contracts (Purchasing)</td>
<td>Profit Center</td>
</tr>
<tr>
<td>Cost Center</td>
<td>Purchase Order</td>
</tr>
<tr>
<td>Customer*</td>
<td>Purchasing Info Record (with conditions)</td>
</tr>
<tr>
<td>Equipment</td>
<td>Routing</td>
</tr>
<tr>
<td>Equipment Task List</td>
<td>Sales Contract</td>
</tr>
<tr>
<td>Exchange Rate</td>
<td>Sales Order</td>
</tr>
<tr>
<td>Fixed Asset (incl. Balances)</td>
<td>Scheduling Agreement</td>
</tr>
<tr>
<td>Functional Location</td>
<td>Selected Set &amp; Selected Set Codes</td>
</tr>
<tr>
<td>Functional Location Task List</td>
<td>Source List</td>
</tr>
<tr>
<td>G/L account balances (classic G/L)</td>
<td>Supplier*</td>
</tr>
<tr>
<td>G/L account open item</td>
<td>TRM Foreign Exchange Spot</td>
</tr>
<tr>
<td>General Task List</td>
<td>TRM Foreign Exchange Swap-Contract</td>
</tr>
<tr>
<td>Inspection Method</td>
<td>TRM Interest Rate Instrument</td>
</tr>
<tr>
<td>Inspection Plan</td>
<td>TRM Interest Rate Swap</td>
</tr>
<tr>
<td>Internal Order</td>
<td>Work Center</td>
</tr>
<tr>
<td>Inventory Balances</td>
<td></td>
</tr>
</tbody>
</table>
Migration Objects

*Supports extension of organizational level.

For more information, see:
- [http://help.sap.com/s4hana_op_1709_001](http://help.sap.com/s4hana_op_1709_001) and search for *Migration Cockpit*.
- SAP Note [2481235](http://help.sap.com/s4hana_op_1709_001): SAP S/4HANA Migration Cockpit (on-premise) - restrictions and extensibility of pre-delivered migration objects

### 7.1.2 SAP Data Services

SAP provides SAP Data Services with Rapid Data Migration content to assist you with importing your data into your SAP S/4HANA system after installation.

For additional information, see:
- SAP Notes [2239701](http://help.sap.com/s4hana_op_1709_001) and [2287723](http://help.sap.com/s4hana_op_1709_001)
- SAP Best Practice content for data migration: [http://rapid.sap.com/bp/RDM_S4H.OP](http://rapid.sap.com/bp/RDM_S4H.OP)

### 7.2 System Configuration for SAP S/4HANA

After you have installed SAP S/4HANA, you have a number of options how to proceed with the system configuration:

1. You follow SAP Activate and SAP Best Practices to guide you through your system configuration.

   **Note**
   
   We strongly recommend that you use SAP Activate and SAP Best Practices as this will simplify both the initial implementation process and future updates of your software.

   SAP Activate is the innovation adoption framework that helps you to implement your SAP S/4HANA system. It provides ready-to-run business and technology processes and guided configurations. For ordering information see SAP Note [2041140](http://help.sap.com/s4hana_op_1709_001) for partners and SAP Note [2202234](http://help.sap.com/s4hana_op_1709_001) for customers. For additional information about SAP Activate and SAP Best Practices, see:
   - SAP S/4HANA Cookbook at [https://wiki.scn.sap.com/wiki/x/HDC7Gg](https://wiki.scn.sap.com/wiki/x/HDC7Gg)
   - [http://rapid.sap.com/bp/BP_OP_ENTPR](http://rapid.sap.com/bp/BP_OP_ENTPR)

2. You use SAP Activate and SAP Best Practices as templates for your system configuration and make changes using the Implementation Guide (IMG). This allows you to adapt the SAP-delivered configuration settings to your specific requirements.
3. You use only the Implementation Guide (IMG) to configure your system.

**Note**

### 7.3 User Assistance Settings

The following sections describe how to enable context-sensitive user assistance for SAP S/4HANA.

#### 7.3.1 Enable User Assistance for the Back-End System

**Enable Context-Sensitive User Assistance**

You need to do these settings in the back-end system which you use to create your system configuration setting. After you have done the settings, you save them, create a transport for them, and transport them to your productive system(s).

Proceed as follows:

2. Select the tab PlainHtmlHttp.
3. Choose New Entries.

You have to create new entries for both documentation and XML documentation areas. To create entries for the documentation area, enter the following values:

<table>
<thead>
<tr>
<th>Name</th>
<th>Value to be entered</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Variant</strong></td>
<td>Enter a name for the variant (any name).</td>
</tr>
<tr>
<td><strong>Platform</strong></td>
<td>Select the platform relevant for your implementation, for example, WN32.</td>
</tr>
<tr>
<td><strong>Area</strong></td>
<td>Select Documentation. This will display as IWBHELP in the table.</td>
</tr>
<tr>
<td><strong>Server Names</strong></td>
<td><a href="https://cp.hana.ondemand.com">https://cp.hana.ondemand.com</a></td>
</tr>
<tr>
<td><strong>Path</strong></td>
<td>dps/d/ahp/1709%20001</td>
</tr>
</tbody>
</table>
To create entries for the XML documentation area, enter the following values:

Table 13:

<table>
<thead>
<tr>
<th>Name</th>
<th>Value to be entered</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Variant</strong></td>
<td>Enter a name for the variant (any name).</td>
</tr>
<tr>
<td><strong>Platform</strong></td>
<td>Select the platform relevant for your implementation, for example, WIN32.</td>
</tr>
<tr>
<td><strong>Area</strong></td>
<td>Select XML Documentation. This will display as XML_DOCU in the table.</td>
</tr>
<tr>
<td><strong>Server Names</strong></td>
<td><a href="https://cp.hana.ondemand.com">https://cp.hana.ondemand.com</a></td>
</tr>
<tr>
<td><strong>Path</strong></td>
<td>dps/d/ahp/1709%20001</td>
</tr>
<tr>
<td><strong>Language</strong></td>
<td>Select the language you need.</td>
</tr>
</tbody>
</table>

4. Repeat step 3 for each relevant platform and language.
5. Select one entry as default per platform.
6. Save your changes and create a transport.

**Enable Product-Specific User Assistance**

After you have done the settings in transaction sr13 described above, you need to enable the product-specific User Assistance with the program rsiwbh04 in transaction se38:

1. Open transaction se38.
2. Enter the program name rsiwbh04 in the Program field and open the program.
3. Under Product-Specific SAP Library enter the ID 2c0e7c571fbeb576e1000000a4450e5 in the Structure/DITA Map ID field.
   - Class must be XDP_STRUCT.
   - The radio button Change must be selected.
4. Run the program.
7.3.2 Enable Context-Sensitive User Assistance for SAP Fiori Launchpad

To make context-sensitive user assistance available in the SAP Fiori launchpad, you need to do the settings described in the following sections:

- Configure the SAP Web Dispatcher [page 22]
- Set Up the User Assistance Plugin [page 24]

7.3.2.1 Configure the SAP Web Dispatcher

Use

If you want to make context-sensitive user assistance available in the SAP Fiori launchpad, you must configure SAP Web Dispatcher.

Prerequisites

You have installed SAP Web Dispatcher 7.5 as the reverse proxy. For more information, see http://help.sap.com/s4hana_op_1709_001

Activities

1. Adjust the SAP Web Dispatcher profile file.
   In the sapwebdisp_pf.txt file, add the following parameters:
   - For the User Assistance Content Platform
     ```
     wdisp/system_<number> = SID=<SID1>, EXTSRV=https://cp.hana.ondemand.com:443, SRCURL=/sap/dfa/help/, SRCSRV=:***, PROXY=<your proxy>:<your proxy port>, STANDARD_COOKIE_FILTER=OFF
     ```
   - For the script server in your production system
     ```
     wdisp/system_<number> = SID=<SID2>, EXTSRV=https://xray.hana.ondemand.com:443, SRCURL=/resources/sap/dfa/help/, SRCSRV=:***, PROXY=<your proxy>:<your proxy port>, STANDARD_COOKIE_FILTER=OFF
     ```
Note

- Make sure that the numbers following `wdisp/system_` are smaller than the numbers that you use for all your application server. The rules for the context-sensitive user assistance need to come before the rules for the application servers.
- Make sure that the SIDs are not the same as your system IDs.

2. Activate the usage of the modification handler:

```
icm/HTTP/mod_0 = PREFIX=/, FILE=$(DIR_PROFILE)/redirect.txt
```

For more information about the profile parameter, see SAP Help Portal at http://help.sap.com/s4hana_op_1709_001

3. Adjust the SAP Web Dispatcher redirect file.

In the `redirect.txt` file, add the following parameters:

```
# User Assistance Content Platform - rewrite rule
if %{SID} = <SID1>
begin
    SetHeader HOST cp.hana.ondemand.com:443
    RegRewriteRawUrl ^/sap/dfa/help/(.*) /dps/$1
end

# Script Server - rewrite rule
if %{SID} = <SID2>
begin
    SetHeader HOST xray.hana.ondemand.com:443
    RegRewriteRawUrl ^/resources/sap/dfa/help/(.*) /xRayControls/resources/sap/dfa/help/$1
end
```

Note

Make sure that the SIDs in the `redirect.txt` file are the same as in the `sapwebdisp_cf.txt` file.

4. You can check if the content platform is working properly through the proxy connection by accessing:

```
https://<your server>:<your port>/sap/dfa/help/odata.svc/?$format=json
```

Example

If the content platform is connected correctly, you can see on your screen the following output, for example:

```
{"d":{"EntitySets":
["Transport","DeliverableForReplication","Tile","Project","Deliverable","TransportHistory","TourIssue","ReplicationTourIssue","Hotspot","Product","Context"]}}
```

5. You can check if the help script server is working properly through the proxy connection by accessing:

```
https://<your server>:<your port>/resources/sap/dfa/help/sap/cfg/XrayBootstrapHelpConfig.json
```
Example

If the help script server is connected correctly, you can see on your screen the following output, for example:

```json
{
    "description": "This configuration registers the Xray bootstrap plug-in",
    "modulePaths": {
        "sap.dfa.help": "/resources/sap/dfa/help/~201509221536~"
    },
    "bootstrapPlugins": {
        "BootstrapXrayPlugin": {
            "module": "sap.dfa.help.utils.adapters.fiori.BootstrapXrayHelpPlugin"
        }
    }
}
```

Result

You can access SAP Fiori launchpad with context-sensitive user assistance.

### 7.3.2.2 Set Up the User Assistance Plugin

To make context-sensitive user assistance available in the SAP Fiori Launchpad, you set up the user assistance plugin in the following way:

1. You create a catalog.
   For more information about creating catalogs, see the documentation on SAP Fiori Launchpad at the SAP Help Portal under [http://help.sap.com/s4hana_op_1709_001](http://help.sap.com/s4hana_op_1709_001) ➤ SAP NetWeaver for SAP S/4HANA ➤ View All ➤ Function-Oriented View ➤ UI Technologies in SAP NetWeaver ➤ SAP Fiori Launchpad ➤ Administration Guide ➤ Initial Setup of the Launchpad ➤.

2. You create a role that references the catalog.
   For more information about creating roles for tile catalogs, see the documentation on SAP Fiori Launchpad at the SAP Help Portal under [http://help.sap.com/s4hana_op_1709_001](http://help.sap.com/s4hana_op_1709_001) ➤ SAP NetWeaver for SAP S/4HANA ➤ View All ➤ Function-Oriented View ➤ UI Technologies in SAP NetWeaver ➤ SAP Fiori Launchpad ➤ Administration Guide ➤ Initial Setup of the Launchpad ➤.

3. You assign the role to every user that needs to access the context-sensitive user assistance.

4. In the catalog, you create a target mapping with the following values:

   **Table 14:**
<table>
<thead>
<tr>
<th>Field Label</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Semantic Object</td>
<td>Shell</td>
</tr>
<tr>
<td>Field Label</td>
<td>Value</td>
</tr>
<tr>
<td>----------------------</td>
<td>--------------------------------------------</td>
</tr>
<tr>
<td><strong>Action</strong></td>
<td>plugin</td>
</tr>
<tr>
<td><strong>Application Type</strong></td>
<td>SAPUI5 Fiori App</td>
</tr>
<tr>
<td><strong>Title</strong></td>
<td>User Assistance Plugin</td>
</tr>
<tr>
<td><strong>URL</strong></td>
<td>/resources/sap/dfa/help/utils/adapters/fiori</td>
</tr>
<tr>
<td></td>
<td>This requires that the SAP Web Dispatcher</td>
</tr>
<tr>
<td></td>
<td>is set up accordingly so that this URL is</td>
</tr>
<tr>
<td></td>
<td>routed to the script server.</td>
</tr>
<tr>
<td><strong>Component</strong></td>
<td>sap.dfa.help.utils.adapters.fiori</td>
</tr>
<tr>
<td><strong>Information</strong></td>
<td>User Assistance Plugin, relevant for all</td>
</tr>
<tr>
<td></td>
<td>app users</td>
</tr>
<tr>
<td><strong>Device Types</strong></td>
<td>Select your required devices:</td>
</tr>
<tr>
<td></td>
<td>○ Desktop</td>
</tr>
<tr>
<td></td>
<td>○ Tablet</td>
</tr>
<tr>
<td></td>
<td>○ Phone</td>
</tr>
<tr>
<td><strong>Parameters</strong></td>
<td>Enter the following parameters in the table:</td>
</tr>
<tr>
<td></td>
<td>○ Name: product; Default Value: SAP_S4HANA_ON-PREMISE</td>
</tr>
<tr>
<td></td>
<td>○ Name: version; Default Value: 1709_001</td>
</tr>
<tr>
<td></td>
<td>○ Name: editor; Default Value: false</td>
</tr>
<tr>
<td></td>
<td><strong>Optional parameters</strong></td>
</tr>
<tr>
<td></td>
<td>○ Name: buttonLocation; Default Value: head</td>
</tr>
<tr>
<td></td>
<td>You can decide where the user assistance</td>
</tr>
<tr>
<td></td>
<td>button should appear by entering</td>
</tr>
<tr>
<td></td>
<td>one of the following values:</td>
</tr>
<tr>
<td></td>
<td>head: The user assistance button</td>
</tr>
<tr>
<td></td>
<td>appears in the SAP Fiori header in the</td>
</tr>
<tr>
<td></td>
<td>top right corner.</td>
</tr>
<tr>
<td></td>
<td>me: The user assistance button</td>
</tr>
<tr>
<td></td>
<td>appears in the Me Area.</td>
</tr>
<tr>
<td></td>
<td>○ Name: showWhatsNew; Default Value: false</td>
</tr>
<tr>
<td></td>
<td>You can decide whether &quot;What’s New&quot;</td>
</tr>
<tr>
<td></td>
<td>information should be displayed on app</td>
</tr>
<tr>
<td></td>
<td>level, if available. (No: false / Yes: true).</td>
</tr>
</tbody>
</table>

After you have made these setting, the user assistance icon is available for the SAP Fiori Launchpad.
7.4 Follow-Up Activities for Advanced Variant Configuration

Integration of the Fiori UI into SAP GUI

You enable the integration of the Advanced Variant Configuration SAP Fiori UI in SAP GUI as described in the product assistance on the SAP Help Portal:


Steps 1 to 3 in the documentation describe how to enable OData calls for the Fiori UI. Step 4 describes the settings required for enabling SAP GUI transactions in the SAP Fiori Launchpad and also contains important information about whitelisting.


This documentation describes how to set up a connection between the back-end system with a front-end server. This is necessary for activating the integrated SAP Fiori UI.

Execute the report VCH_MASS_MAINTENANCE

You use this report for the initial preparation of your variant configuration data for SAP S/4HANA Advanced Variant Configuration. For information about how to use the report, see the system documentation in transaction SE38 or SE80, click on the Goto menu, and select Documentation.

Post-Installation Steps for VCH AFL

An Application Function Library (AFL) extends the SAP HANA Database with functions required for business applications - specifically, the VCH AFL (Variant Configuration on SAP HANA) extends the SAP HANA Database with functions to run SAP S/4HANA Advanced Variant Configuration. After you have installed VCH AFL (SAP VCH AFL FOR SAP HANA 1.00), you need to do some post-installation steps for the VCH AFL described in SAP Note 2527105.

i Note

For information about the installation of this component, see Installation Documentation [page 8]: SAP HANA Server Installation and Update Guide.
7.5 Follow-Up Activities for Analytics

To enable the use of Analytics with SAP S/4HANA, you need to set up the Analytic Engine. For information how to do so, see SAP Note 2289865.

7.6 Installation of SAP Fiori

The SAP Fiori UIs need to be installed for SAP S/4HANA. You have the following two installation options for SAP Fiori:

- **As add-on**
  
  This is the embedded installation option, that is, the installation of Fiori UIs on the SAP S/4HANA 1709 backend system.

- **As standalone server on a SAP NetWeaver system**
  
  This is the hub installation option, with the SAP Fiori UIs installed on the SAP NetWeaver AS for ABAP 7.52 for SAP S/4HANA 1709 front-end server.

For more information about the installation and configuration of SAP Fiori, see the SAP Help Portal at https://help.sap.com/fiori_implementation.

7.7 Installation of the PI Adapters for Elster and Swift

The Advanced Adapter Engine Extended (AEX) is required for the installation of the Process Integration Adapters for Elster and Swift. AEX is part of SAP NetWeaver 7.52 for SAP S/4HANA 1709 as described in the section **Product Information [page 11]**. For more information about Elster and Swift, see also SAP Notes 1802839 and 1064419.

You have the following two options how to install the Elster/Swift adapters:

1. **Installation from DVD**

   With this option, you copy the archives from the DVD location \S4HANA10JAVA\DATA_UNITS\S4_JAVA to the directory /usr/sap/trans/EPS/ and use the Software Update Manager (SUM) to deploy the files using the option **Manually prepared directory**.

   For more information how to use the SUM tool, see SUM guides at https://support.sap.com/sitoolset. Select the guide according to your operating systems and database.
2 Installation with Maintenance Planner

With this option, you use Maintenance Planner to generate a stack XML file with the Elster and Swift support package stack information that you then hand over to the Software Update Manager (SUM) tool.


7.8 Creating RFC Destinations for liveCache Applications

You use this procedure to use liveCache across clients, for example, to initialize liveCache correctly.

1. Create a user with the following authorizations in all production clients:
   - Cross-application AAAB authorization objects
     - Authorization object: S_TCODE Value: SE38
     - Authorization object: S_RFC Activity: 16
     - Name of RFC object to be protected : /SAPAPO/DM_LC_SYNC, SYST
     - Type of RFC object to be protected : FUGR
   - Basis development environment BC_C
     - Authorization object: S_DEVELOP Value: 03, 16
     - Authorization object: S_PROGRAM
     - User action ABAP/4 program : *
     - Authorization gr. ABAP/4 program : (no input necessary)
   - Basis administration BC_A
     - Authorization object: 'S_BTCH_JOB'
     - User action: 'RELE'

   **Note**
   Ensure that the user no longer has the initial password in any of the clients.

2. In each client, create a RFC destination by performing the following substeps:
   1. Start transaction SM59.
   2. Choose Create.
   3. Add a CLNT string and the client number (for example, "678") to your system ID (for example, "XYZ") to determine the connection name.

   **Note**
   This constitutes the connection name (for example, "XYZCLNT678"). You must adhere to this naming convention as ABAP does not recognize other names, for example, "XYZMAND678", and causes errors. If there is already a connection with the same destination but a different name, you must still create the connection as described.

   4. Enter the connection name in RFC destination.
   5. As a connection type, choose "3" (= SAP S/4HANA backend system destination or connection to the ABAP system).
6. Enter a description for the destination.
7. In the Logon section, enter the user credentials of the user created in this client in step 1.

   i Note
   Ensure that the password is no longer initial, and do not select Current User.

8. Save the changes.

Verifying the Above Steps

To check that you have carried out all the steps correctly, choose Remote Login.

The system should display an SAP S/4HANA backend system window, but not an SAP S/4HANA backend system logon screen. If the system displays an SAP S/4HANA backend system logon screen, check if all steps above were performed correctly, you should check whether or not the user is actually available in this client (in particular). This test is not possible with an RFC destination with a CPIC user.

   i Note
   You create the same user in each client only once. You must, however, ensure that the clients of the destination and user match. The user may also be a CPIC user. The authorization "Authorization object: S_TCODE Value: SE38" and similar should be assigned here also. You should also check if you can implement SAP Note 536291.

7.9   Follow Up Activities in Master Data Governance

Gateway Buffering in Test Systems

To avoid very slow performance, the metadata cache and usage of shared memory for caching options need to be activated. In productive systems, metadata caching is active by default. However, if you are working in test systems you have to activate the Gateway metadata caching (buffering) manually. These settings have to be performed on the frontend system where the Gateway server is installed.

To manually activate these settings, in a test system, you do the following:

1. Go to the Gateway system with transaction /IWFND/MED_ACTIVATE, or in Customizing by the IMG path SAP NetWeaver > SAP Gateway > OData Channel > Administration > Cache Settings > Metadata > Activate or Deactivate Cache.
2. Select the Activate Metadata Cache check box
3. Select the Use Shared Memory for Caching check box
Follow-Up Activities for Environment, Health, and Safety

After the installation, you need to carry out the following activities for Environment, Health, and Safety:

- In transaction SICF, activate the following WebDynpro services below the node /default_host/sap/bc/webdynpro/sap/:
  - All EHFND* and EHHSS* services
  - POWL
  - IBO_WDA_INBOX
  - WDR_CHIP_PAGE
- Also activate the following services:
  - NWBC runtime node on the path /default_host/sap/bc/nwbc.
  - SAPUI5 application handler on the path /default_host/sap/bc/ui5_ui5 and on the path /default_host/sap/public/bc/ui5_ui5.
- Copy the delivery Customizing from client 000 into your other clients.
- Make the relevant settings in the Customizing activities for Environment, Health, and Safety under Foundation for EHS and under Incident Management, under Health and Safety Management, or under Environment Management.
7.11 Follow-Up Activities for Enterprise Portfolio and Project Management

7.11.1 Follow-Up Activities for SAP Portfolio and Project Management

Navigation

To enable the navigation, carry out the following manual steps:


2. From the delivery client, copy the data from the Customizing tables mentioned below using transaction /n/RPM/CUST_COPY:
   - /RPM/DASH_PERS: Dashboard Customization
   - /RPM/DASH_ROLE: Dashboard Attributes Override Table
   - INM_NAV_CTX: INM Navigation Context
   - INM_NAV_CTX_W: INM Navigation Context Workcenter
   - INM_NAV_INF_W: INM Navigation Information

3. Manually adjust and compare the Customizing data with the delivery client using transaction SCU0.

4. Initially all dashboard fields are displayed as standard fields. With this, it is not possible to navigate to the object windows. To activate the links to the object windows, select the Link checkbox in Customizing for SAP Portfolio and Project Management under Portfolio Management ➤ Global Customizing ➤ Global Field Settings ➤ Dashboard Settings ➤ Define Fields for Dashboards. You can also copy the Customizing for the dashboards by copying /RPM/DASHBOARD using transaction /n/RPM/CUST_COPY.

⚠️ Caution

This transaction copies the standard Customizing for all dashboards and invalidates all customer-specific Customizing for the dashboards. Object-type-specific copying is not supported by transaction /n/RPM/CUST_COPY.
7.11.2 Follow-Up Activities for Commercial Project Management

7.11.2.1 Overall Implementation Sequence

This section describes the implementation sequence for Project Workspace, Project Cost and Revenue Planning, and Project Issue and Change Management.

Based on your business needs, you can choose one of the following component combinations as a deployment option:

<table>
<thead>
<tr>
<th>Deployment Option</th>
<th>Project Workspace</th>
<th>Project Cost and Revenue Planning</th>
<th>Project Issue and Change Management</th>
<th>SAP BusinessObjects Analysis for Microsoft Office (Analysis Office)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Option 1</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>Option 2</td>
<td>x</td>
<td>x</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Option 3</td>
<td>x</td>
<td></td>
<td>x</td>
<td></td>
</tr>
<tr>
<td>Option 4</td>
<td>x</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Option 1

Install Project Workspace, Project Cost and Revenue Planning, and Project Issue and Change Management with Analysis Office (AO):

1. Activate the /CPD/CA_CPD_PWS_1 business function (see transaction SFW5) Enterprise Business Functions /CPD/CA_CPD_PWS_1).

   **Note**

   The activation of the business function OPS_PS_CI_1 is a prerequisite for working with Project System (PS) projects.

2. Activate the /CPD/CA_CPD_PFP_1 business function (see transaction SFW5) Enterprise Business Functions /CPD/CA_CPD_PFP_1).

3. Activate the /PICM/CA_CPD_PICM_1 business function (see transaction SFW5) Enterprise Business Functions /PICM/CA_CPD_PICM_1).

4. Install NWBC for Desktop (optional).

5. Install Analysis Office (see SAP note 2188859).

6. Enable Planning Application Kit (PAK). PAK allows you to use the workbooks of SAP BusinessObjects Analysis, edition for Microsoft Office as part of the Commercial Project Management content.

   **Procedure**

   1. Get the latest information posted in SAP note 1637199.
   2. In the back-end system, launch table/view maintenance (transaction SM30).
   3. Enter RSPLS_HDB_ACT in the table/view field and choose Maintain.
   4. Choose New Entries.
   5. In the HANA Integrtn. Active column, select Deep HANA Integration Active; and in the Functn. Active column, mark the checkbox.
   6. Commercial Project Management uses the BW layer that is available in each NetWeaver stack.
Caution

Project Cost and Revenue Planning uses BW Integrated Planning (BW-IP), which uses real-time InfoCubes to capture data generated through input-ready queries and planning functions. Therefore, only a configuration of the local BI client is required (and not an additional BI system).

For setting up Project Cost and Revenue Planning, see SAP note 2363617.

8. You must activate the analytics content under info-areas /CPD/AVR and /PICM/AVR. For information about setting up Analytics, see SAP Note 1999149.

9. You must follow these steps to enable delivery customizing in the relevant clients:
   1. Go to transaction SFW_BROWSER
   2. Expand the business function /CPD/CA_CPD_PWS_1
   3. Double-click on switch /CPD/CA_CPD_SFWS_PWS_1 to implement BC set activation.
   4. Choose the Activate Dependent BC Sets button.
   5. In the dialog box, select Activate Switch BC Sets and choose Continue.
   6. In the next dialog box, select the following:
      1. Only Logon client for Cascading BC Sets
      2. Activate in logon client for Non-Cascading BC sets
      3. Activate for Cross-Client BC sets
      4. Mark the checkboxes to ignore previous activations and ignore table delivery class for a new installation
   7. Repeat the BC set activation steps for the switch /CPD/CA_CPD_SFWS_PWS_S4_1.
   8. Expand the business function /CPD/CA_CPD_PFP_1.
   9. Repeat the BC set activation steps for the switch /CPD/CA_CPD_SFWS_PFP_1.
  10. Expand the business function /PICM/CA_CPD_PICM_1.
  11. Repeat the BC set activation steps for the switch /PICM/CA_CPD_SFWS_PICM_1.

10. Check and activate SICF services as follows:
   1. Go to transaction SICF.
   2. Choose Execute.
   3. Go to default host sap bc webdynpro.
   4. Ensure that all services under the cpd node are active.
   5. Ensure that all services under the picm node are active.

11. BRF+ framework is used within analytics and the processing of change requests in Project Issue and Change Management. Import the BRF+ customizing application as follows:
   ○ Client 000
      1. Run the report FDT_TRANS
      2. Provide the relevant customizing request
      3. Enter the object ID as 7C63E6507DA2A220E10000000A428544
      4. Enter the object ID as 38EAA71741841EE59FAD4B491883514
      5. Enter the object ID as F0D5105146757029E10000000A42852B
      6. Select the Transport Whole Application(s) radio button
   ○ Productive Client
      1. Launch the transaction SCC1
      2. Enter the source client as 000
      3. Provide the transport request in which you have transported the application (from client 000)
4. Mark the checkbox *Include Tasks in Requests*
5. Execute the transaction

Option 2

**Install Project Workspace and Project Cost and Revenue Planning with Analysis Office (AO):**

1. Activate the `/CPD/CA_CPD_PWS_1` business function (see transaction SFW5) ➤ *Enterprise Business Functions* ➤ `/CPD/CA_CPD_PWS_1`.

   **Note**
   The activation of the business function `OPS_PS_CI_1` is a prerequisite for working with Project System (PS) projects.

2. Activate the `/CPD/CA_CPD_PFP_1` business function (see transaction SFW5) ➤ *Enterprise Business Functions* ➤ `/CPD/CA_CPD_PFP_1`.
3. Install NWBC for Desktop (optional).
4. Install Analysis Office (see SAP note 2188859).
5. Enable *Planning Application Kit* (PAK). PAK allows you to use the workbooks of SAP BusinessObjects Analysis, edition for Microsoft Office as part of the Commercial Project Management content.

   **Procedure**
   1. Get the latest information posted in SAP note 1637199.
   2. In the back-end system, launch table/view maintenance (transaction SM30).
   3. Enter `RSPLS_HDB_ACT` in the table/view field and choose *Maintain*.
   4. Choose *New Entries*.
   5. In the *HANA Integrtn. Active* column, select *Deep HANA Integration Active*; and in the *Functn. Active* column, mark the checkbox.
6. Commercial Project Management uses the BW layer that is available in each NetWeaver stack.

   **Caution**
   Project Cost and Revenue Planning uses BW Integrated Planning (BW-IP), which uses real-time InfoCubes to capture data generated through input-ready queries and planning functions. Therefore, only a configuration of the local BI client is required (and not an additional BI system).

   For setting up Project Cost and Revenue Planning, see SAP note 2363617.
7. You must activate the analytics content under info-area `/CPD/AVR`. For information about setting up Analytics, see SAP Note 1999149.
8. You must follow these steps to enable delivery customizing in the relevant clients:
   1. Go to transaction `SFW_BROWSER`
   2. Expand the business function `/CPD/CA_CPD_PWS_1`
   3. Double-click on switch `/CPD/CA_CPD_SFWS_PWS_1` to implement BC set activation.
   4. Choose the *Activate Dependent BC Sets* button.
   5. In the dialog box, select *Activate Switch BC Sets* and choose *Continue*.
   6. In the next dialog box, select the following:
      1. *Only Logon client for Cascading BC Sets*
      2. *Activate in logon client for Non-Cascading BC sets*
      3. *Activate for Cross-Client BC sets*
4. Mark the checkboxes to ignore previous activations and ignore table delivery class for a new installation.

7. Repeat the BC set activation steps for the switch `/CPD/CA_CPD_SFWS_PWS_S4_1`.

8. Expand the business function `/CPD/CA_CPD_PFP_1`.

9. Repeat the BC set activation steps for the switch `/CPD/CA_CPD_SFWS_PFP_1`.

9. Check and activate SICF services as follows:
   1. Go to transaction SICF.
   2. Choose Execute.
   3. Go to `default host sap bc webdynpro`.
   4. Ensure that all services under the `cpd` node are active.

10. BRF+ framework is used within analytics. Import the BRF+ customizing application as follows:
    ○ **Client 000**
      1. Run the report `FDT_TRANS`.
      2. Provide the relevant customizing request.
      3. Enter the object ID as `7C63E6507DA2A20E10000000A428544`.
      4. Enter the object ID as `38EAA71741841EE59EFAD4B491883514`.
      5. Select the `Transport Whole Application(s)` radio button.
    ○ **Productive Client**
      1. Launch the transaction `SCC1`.
      2. Enter the source client as `000`.
      3. Provide the transport request in which you have transported the application (from client 000).
      4. Mark the checkbox `Include Tasks in Requests`.
      5. Execute the transaction.

**Option 3**

Install Project Workspace and Project Issue and Change Management with Analysis Office (AO):

1. Activate the `/CPD/CA_CPD_PWS_1` business function (see transaction SFW5)` Enterprise Business Functions` `/CPD/CA_CPD_PWS_1`.

   **Note**
   The activation of the business function `OPS_PS_CI_1` is a prerequisite for working with Project System (PS) projects.

2. Activate the `/PICM/CA_CPD_PICM_1` business function (see transaction SFW5)` Enterprise Business Functions` `/PICM/CA_CPD_PICM_1`.

3. Install NWBC for Desktop (optional).

4. Install Analysis Office (see SAP note 2188859).

5. You must activate the analytics content under info-areas `/CPD/AVR` and `/PICM/AVR`. For information about setting up Analytics, see SAP Note 1999149.

6. You must follow these steps to enable delivery customizing in the relevant clients:
   1. Go to transaction `SFW_BROWSER`.
   2. Expand the business function `/CPD/CA_CPD_PWS_1`.
   3. Double-click on switch `/CPD/CA_CPD_SFWS_PWS_1` to implement BC set activation.
   4. Choose the `Activate Dependent BC Sets` button.
5. In the dialog box, select **Activate Switch BC Sets** and choose **Continue**.
6. In the next dialog box, select the following:
   1. **Only Logon client for Cascading BC Sets**
   2. **Activate in logon client for Non-Cascading BC sets**
   3. **Activate for Cross-Client BC sets**
   4. Mark the checkboxes to ignore previous activations and ignore table delivery class for a new installation
7. Repeat the BC set activation steps for the switch /CPD/CA_CPD_SFWS_PWS_S4_1.
8. Expand the business function /PICM/CA_CPD_PICM_1.
9. Repeat the BC set activation steps for the switch /PICM/CA_CPD_SFWS_PICM_1.
7. Check and activate SICF services as follows:
   1. Go to transaction **SICF**.
   2. Choose **Execute**.
   3. Go to **default host sap bc webdynpro**.
   4. Ensure that all services under the cpd node are active.
   5. Ensure that all services under the picm node are active.
8. BRF+ framework is used within analytics and the processing of change requests in Project Issue and Change Management. Import the BRF+ customizing application as follows:
   - **Client 000**
     1. Run the report **FDT_TRANS**
     2. Provide the relevant customizing request
     3. Enter the object ID as 7C636507DA2A220E10000000A428544
     4. Enter the object ID as 38EAA71741841EE59EFAD4B491883514
     5. Enter the object ID as F0D51051446757029E10000000A42852B
     6. Select the **Transport Whole Application(s)** radio button
   - **Productive Client**
     1. Launch the transaction **SCC1**
     2. Enter the source client as **000**
     3. Provide the transport request in which you have transported the application (from client 000)
     4. Mark the checkbox **Include Tasks in Requests**
     5. Execute the transaction

**Option 4**

**Install Project Workspace with Analysis Office (AO):**

1. Activate the /CPD/CA_CPD_PWS_1 business function (see transaction SFW5) **Enterprise Business Functions**
   */CPD/CA_CPD_PWS_1*.

**i Note**
The activation of the business function **OPS_PS_CI_1** is a prerequisite for working with Project System (PS) projects.

2. Install NWBC for Desktop (optional).
3. Install Analysis Office (see SAP note 2188859).
4. You must activate the analytics content under the info-area /CPD/AVR. For information about setting up Analytics, see SAP Note 1999149.
5. You must follow these steps to enable delivery customizing in the relevant clients:
   1. Go to transaction SFW_BROWSER
   2. Expand the business function /CPD/CA_CPD_PWS_1
   3. Double-click on switch /CPD/CA_CPD_SFWS_PWS_1 to implement BC set activation.
   4. Choose the Activate Dependent BC Sets button.
   5. In the dialog box, select Activate Switch BC Sets and choose Continue.
   6. In the next dialog box, select the following:
      1. Only Logon client for Cascading BC Sets
      2. Activate in logon client for Non-Cascading BC sets
      3. Activate for Cross-Client BC sets
      4. Mark the checkboxes to ignore previous activations and ignore table delivery class for a new installation
   7. Repeat the BC set activation steps for the switch /CPD/CA_CPD_SFWS_PWS_S4_1.
6. Check and activate SICF services as follows:
   1. Go to transaction SICF.
   2. Choose Execute.
   3. Go to default host sap bc webdynpro.
   4. Ensure that all services under the cpd node are active.
7. BRF+ framework is used within analytics. Import the BRF+ customizing application as follows:
   - **Client 000**
     1. Run the report FDT_TRANS
     2. Provide the relevant customizing request
     3. Enter the object ID as 7C63E6507DA2A220E10000000A428544
     4. Enter the object ID as 38EAA71741841EE59EFAD4B491883514
     5. Select the Transport Whole Application(s) radio button
   - **Productive Client**
     1. Launch the transaction SCC1
     2. Enter the source client as 000
     3. Provide the transport request in which you have transported the application (from client 000)
     4. Mark the checkbox Include Tasks in Requests
     5. Execute the transaction

### 7.11.2.2 Settings for Project Workspace

**Schema Mapping**

For the HANA content of Commercial Project Management, you must map the `SAP_ECC` schema to the `SAP <SID>` schema.

**Configuration of Display Options for Analytical Reports**

Analytical UIBBs are used in Project Workspace to display reports such as Progress Analysis, Work in Progress, and Project Cost Status. By default, these reports are displayed in a SAP List Viewer (ALV) table. However, you can
also choose to view these reports as a graphic, or a table and graphic, or using Crystal Reports. To enable additional options for displaying reports, it is necessary to make the following Customizing settings:

To configure options for Graphic and Table and Graphic displays, follow these steps:

1. In Customizing for SAP NetWeaver, choose [Ui Technologies > SAP List Viewer (ALV) > Maintain Web Dynpro ABAP-Specific Settings].
2. Mark the Java Server Available checkbox.

**Note**

The display options are available in the frontend only if you also have enabled a Java server.

To configure options for Crystal Reports, follow these steps:

1. In Customizing for SAP NetWeaver, choose [Ui Technologies > SAP List Viewer (ALV) > Maintain SAP GUI-Specific Settings].
2. Mark the Allow Crystal Reports checkbox.

**Note**

- Commercial Project Management does not deliver any Crystal Report template for viewing reports.
- Crystal reporting requires a special viewer in the frontend. This setting is only meaningful if this viewer has been installed. For more information, see SAP note 1353044.

Set-Up for Launching Native Transactions in Project Workspace

To launch native SAP transactions using the launchpad in Project Workspace, you must activate the MIME Repository service in the following way:

1. On the SAP Easy Access screen, choose [Tools > Administration > Administration > Network > HTTP Service Hierarchy Maintenance].
2. On the Maintain Services screen, select the hierarchy type Service and choose Execute.
3. In the Virtual Hosts / Services hierarchy, navigate to the MIME Repository service by choosing [default_host > sap > public > bc > its > mimes].
4. Right-click and choose Activate Service.

Definition of RFC Destinations for Charts

The Fiori-themed analytics content of Commercial Project Management uses charts based on WebDynpro ABAP technology. To connect the IGS (Internet Graphics Server) to the SAP system, you have to create an RFC destination in the SAP system. For more information, see SAP note 454042.

Activation of Relevant OData Services

In Commercial Project Management, the following OData service must be activated:

CPD_MASTERPROJECT_OVERVIEW_SRV

Installation and Upgrade of BW

For information about the new and changed objects in this release, see SAP note 2526289.

Enabling Enterprise Search
In Commercial Project Management, the following search connectors must be set up:

- Commercial Project
  - Model Name: MASTERPROJECT_H
  - Connector Name: Commercial Project
- Financial Plan
  - Model Name: FINANCIALPLAN_H
  - Connector Name: Financial Plan
- Change Request
  - Model Name: CHANGEREQUEST_H
  - Connector Name: Change Request (Commercial Project)
- Issue
  - ISSUECHANGEREQ_H
  - Connector Name: Issue (Commercial Project)

The connector ID is generated automatically when the connector is created and the name of the connector can be edited. For more information, see SAP note 2382734.

Role for Adding Fiori Apps in the Fiori Launchpad

To add the Fiori apps of Commercial Project Management in the Fiori launchpad, the following role is required: SAP_BR_PROJECTMGR_COMMPRJ (Project Manager (CPM)).

Set-Up for Linking Commercial Projects to CRM Opportunities

To be able to link commercial projects to CRM opportunities, you must provide the HTTP connection to the CRM system (by defining the RFC destination (CPD_CRM) (connection type H)).

Predefinition of Project Workspace Views

For the predefinition of Project Workspace views for the personalization for end users, see SAP note 2011052.

7.11.2.3 Settings for Project Cost and Revenue Planning

Schema Mapping

For the HANA content of Commercial Project Management, you must map the SAP_ECC schema to the SAP <SID> schema.

Set-Up of the Planning Group

After installing the latest SP of SAP BusinessObjects Analysis, edition for Microsoft Office, follow these steps to activate the default planning options in workbooks:

1. Launch a planning workbook and navigate to File ➤ Commercial Project ➤ Settings ➤
2. In the Settings dialog box, choose the Advanced tab, select Show Planning Group.
3. Close and relaunch the planning workbook.

Set-Up of SAP Multiresource Scheduling (MRS)

Project Cost and Revenue Planning allows you to update staffing information in SAP Multiresource Scheduling. For more information about the compatibility of Commercial Project Management with SAP Multiresource Scheduling, see SAP Note 2363617.
Enhancing Workbooks for SAP BusinessObjects Analysis, edition for Microsoft Office

The delivered workbooks contain input-ready queries and planning objects, launched in a Microsoft Excel-based frontend for planning. We recommend that you use the delivered workbooks as templates and create your own workbooks to suit individual requirements. To know more about creating planning workbooks, see the relevant guides in https://help.sap.com/viewer/p/SAP_BUSINESSOBJECTS_ANALYSIS_OFFICE. We also recommend that you use the delivered input-ready queries as templates and create your own queries to suit your requirements.

Disabling the Intelligent Double-Click Function in SAP BusinessObjects Analysis, edition for Microsoft Office

**Note**

This setting is available only in SAP BusinessObjects Analysis, edition for Microsoft Office 1.4 SP02 and above.

When you double-click a cell, the intelligent double-click function (if enabled) automatically executes the first command in the context menu of the cell.

To disable the intelligent double-click function, do the following:

1. Launch Registry Editor. To know more about maintaining registry settings for SAP BusinessObjects Analysis, edition for Microsoft Office, see the relevant guides in https://help.sap.com/viewer/p/SAP_BUSINESSOBJECTS_ANALYSIS_OFFICE.
2. Depending on the type of installation, do one of the following:
   - If you are using a 32-bit operating system, locate the AdvancedAnalysis folder either under HKEY_CURRENT_USER\Software\SAP or HKEY_LOCAL_MACHINE\Software\SAP.
   - If you are using a 64-bit operating system, locate the Wow6432Node either under HKEY_CURRENT_USER\Software\SAP or HKEY_LOCAL_MACHINE\Software\SAP.
3. In the identified path, create nested keys to form the path `*\Software\SAP\AdvancedAnalysis\Settings\ExcelGrid`.
4. Under ExcelGrid, create the string `EnableDoubleClick`, and enter the value `False`.

Installation and Upgrade of BW

For information about the new and changed objects in this release, see SAP note 2522216.

Enhancing HANA Views to Add New Resources

1. Launch HANA Studio.
2. Go to the package sap\cpms4h\pfp\Calculation Views.
3. Right-click on CV_RESOURCE_0ACT and choose Copy.
4. Right-click on the Calculation Views folder and paste the selection.
5. Enter the view name as CVRESOURCE(resource type), for example, CV_ RESOURCE_0MRS.
7. On the right panel, right-click on RES_TYPE_ID and choose Remove.
8. Open the calculated column RES_TYP and change the name to RES_TYPE_ID.
9. Remove the check in the Hidden checkbox and in the expression editor, enter the resource type ID (for example 0MRS). Choose OK.
10. Save and activate your changes.
11. Open the CVRESOURCE HANA view and add the projection to the HANA view.
12. Add the newly created HANA view (CVRESOURCE(resource type) (for example, CVRESOURCE_0MRS)) into Projection_7.
13. Right-click Projection_7 and choose Add All To Output.
14. Connect Projection_7 to Union_1.
15. Map the source and target fields as follows:

<table>
<thead>
<tr>
<th>Source</th>
<th>Target</th>
</tr>
</thead>
<tbody>
<tr>
<td>MANDT</td>
<td>MANDT</td>
</tr>
<tr>
<td>PLAN_SCEN_ID</td>
<td>PLAN_SCEN_ID</td>
</tr>
<tr>
<td>RES_TYPE_ID</td>
<td>RES_TYPE_ID</td>
</tr>
<tr>
<td>SPRAS</td>
<td>SPRAS</td>
</tr>
<tr>
<td>MCTXT</td>
<td>MAKTG</td>
</tr>
<tr>
<td>LSTAR</td>
<td>MATNR</td>
</tr>
<tr>
<td>KOKRS</td>
<td>KOKRS</td>
</tr>
</tbody>
</table>

16. Save and activate your changes.

Data Consistency of Forecasting Method Descriptions During Upgrade

If you upgrade to Commercial Project Management 1709 onwards from the lower add-on releases SAP Commercial Project Management for S/4HANA 2.0 SP01 and SP02, you must execute the following report to ensure data consistency of forecasting method descriptions: /CPD/PFP_FORECAST_DATA_TRANS

Clean-Up of Invalid FBI Structures

To clean up invalid FPM BOPF Integration (FBI) structures, you must run the /BOFU/R_FBI_VIEW_CLEANUP_DDIC report.

1. In transaction SE38, run /BOFU/R_FBI_VIEW_CLEANUP_DDIC
2. In the selection screen, remove the checks in the following checkboxes:
   ○ Inactive Only
   ○ Deleted Objects Only
   ○ Test Mode
3. Choose Execute
4. The system lists inconsistent objects (from the following list). Select the objects that are listed by the system.
   ○ Business Object
     ○ /BOBF/ATTACHMENT_FOLDER
   ○ FBI View
     ○ /CPD/PWS_MP_STEXT
     ○ /CPD/PWS_MP_LIST
     ○ /BOFU/VIEW_ATF_DOC
     ○ /BOFU/VIEW_ATF
     ○ /CPD/WDC_PFP_HEADER_TEXT_FBIVIEW
     ○ /CPD/WDC_PFP_HEADER_FBIVIEW
     ○ /CPD/WDC_PFP_VERSION_FBIVIEW
     ○ /CPD/WDC_PFP_STRUCTURE_FBIVIEW
     ○ /CPD/PWS_MP_PROJ_MEMBER
Choose Cleanup.

7.12 Follow-Up Activities for Product Safety and Stewardship

7.12.1 Follow-Up Activities for Product Compliance

For successful installation, always check the release information note 2278589 for the most current implementation details.

After the installation, carry out the following activities for Product Compliance for Discrete Industries:

- Verify and activate the following BC sets depending on the processes you need.
  - For the process Managing Product Compliance:
    - EHPRC_SPECIAL Critical PRC Customizing from other components
    - EHPRC_BASIC Customizing for Product and REACH Compliance
    - EHPRC_DI_PRODUCT_COMPLIANCE Managing Product Compliance
  - For the process Managing IMDS Compliance:
    - EHPRC_SPECIAL Critical PRC Customizing from other components
    - EHPRC_BASIC Customizing for Product and REACH Compliance
    - EHPRC_DI_IMDS_COMP Managing IMDS Compliance
  - For both above mentioned processes:
    - EHPRC_SPECIAL Critical PRC Customizing from other components
    - EHPRC_BASIC Customizing for Product and REACH Compliance
    - EHPRC_DI Customizing for Product Compliance

- Verify and carry out all Customizing steps under SAP Customizing Implementation Guide Product Safety and Stewardship Product Compliance for Discrete Industries.

- In transaction SICF, activate the following WebDynpro services below the node /default_host/sap/bc/webdynpro/sap/:
  - All EHFN* and EHPRC* services
  - POWL
  - IBO_WDA_INBOX
  - WDR_CHIP_PAGE

- Also activate the following services:
  - NWBC runtime node on the path /default_host/sap/bc/nwbc.
  - SAPUI5 application handler on the path /default_host/sap/bc/ui5_ui5.
7.12.2 Follow-Up Activities for Product Safety and Stewardship for Process Industries

For successful installation, always check the release information note 2278589 for the most current implementation details.

After the installation, you need to carry out follow-up activities as described in the following SAP Notes:

- For information regarding installation instructions for Windows Wordprocessor Integration (WWI) and Expert / Open Content Connector (OCC), see SAP Note 568302.
- For information regarding installation instructions for the WWI server, see SAP Note 1394553.

7.13 Follow-Up Activities for Supplier and Category Management

After the installation, you need to carry out the following activities for Supplier and Category Management:

Delivery Customizing

You have to copy the delivery Customizing for Supplier and Category Management from client 000 to your relevant clients. You can run transaction Customizing Cross-System Viewer (SCU0) to compare Customizing contents in the 000 client and in the client in your system. For Supplier and Category Management, the following application components are relevant:

- SLC-EVL, SLC-ACT, SLC-CAT for Supplier and Category Management Customizing
- BC-SRV-NUM for number range intervals required for purchasing categories, activities, tasks, and for the objects used in Supplier Evaluation
- CA-GTF-SGF for Web Dynpro launchpad and OBN Customizing
- CA-GTF-SGF-POW for POWL Customizing
- BC-SEC-AUT-PFC for PFCG role Customizing

In addition, you must copy alert texts with text ID ‘ALRT ’ and text names EVAL_REMINDER* and TASK* to the productive client. For more information, see SAP Note 601619.

Important SAP Notes

Define the system characteristic as described in SAP Note 2224695.
Activate Internet Communication Framework (ICF) Services

For information about the ICF services that you have to activate for Supplier and Category Management, see the configuration information for Supplier and Category Management. This documentation is included in the product assistance for SAP S/4HANA that is available on SAP Help Portal at http://help.sap.com/s4hana_op_1709_001.

**Note**
This documentation also contains further information about the implementation of Supplier and Category Management, such as jobs that must be scheduled and roles that need to be assigned.

7.14 Follow-Up Activities for Human Resources (Compatibility Packs)

7.14.1 Integration in SAP S/4HANA

**Introduction**

The recommended HCM solution for SAP S/4HANA is the SAP SuccessFactors HCM Suite. You can use the existing integration based on HANA Cloud Integration (HCI) to connect SAP SuccessFactors to the SAP S/4HANA system.

**Note**
No integration is required if the SAP S/4HANA system is used to store the data. This information is only relevant if you want to replicate data from your HR master system to the SAP S/4HANA system.
To transition into SAP S/4HANA system, it is important that at least the basic employee master data related infotypes (that is, infotypes 0,1,2,3,6,7,9,105) are moved into the PA table and then this data is synchronized with BP in SAP S/4HANA system. Currently, the following transition options are available:

![Transition Options in SAP S/4HANA](image)

This document is only relevant if you are using integration options for SAP S/4HANA, that is, options 1, 3 and 4.

1. The following integration option is available for new customers:
   - If you are a new SAP HR or SAP S/4HANA (without a legacy SAP HCM system) customer, then you can implement SAP SuccessFactors and connect EC with SAP S/4HANA (Option 1 from the diagram)

2. The following integration options are available for existing customers.
   - If you are an SAP S/4HANA customer also using SAP ERP HCM and are not able to make the move to SAP SuccessFactors in the near term, you can continue to use SAP ERP HCM. You have 2 options:
     - Running SAP ERP HCM on a separate instance, integrated via ALE with SAP S/4HANA (Option 3 in diagram)
     - Running SAP ERP HCM on same instance with SAP S/4HANA (co-deployed)(Option 4 in diagram)
   This integration helps minimize disruption in your HR processes during the SAP S/4HANA migration and enables the ability to migrate your HR processes to SAP SuccessFactors whenever you are ready.

### 7.14.2 Integration Scenarios

#### 7.14.2.1 Implementing SAP SuccessFactors

You can use this prepackaged integration to replicate employee master data and organizational data from SAP SuccessFactor Employee Central to the SAP S/4HANA system and cost center data from SAP S/4HANA to SAP SuccessFactor Employee Central, if you are using SAP SuccessFactors Employee Central as your HR master data system.
Based on your business requirements, you can:

- Replicate the employee mini master (basic infotypes) for using employee data in processes that are not HR specific.
- Replicate the employee global infotypes for using employee data in HR specific processes such as payroll.

Prerequisites

In SAP S/4HANA system there has to be the Integration Add-On software component `PA_SECRET` installed which does the inbound processing of the receiving Employee and Organizational data from SAP SuccessFactors via HCI.

Steps for Execution

Implementing HR Mini Master Data

You can replicate the basic PA infotypes and exclude the payroll infotypes from the integration. In this case, you can filter out the payroll specific infotypes during configuration and can skip the payroll related steps from the integration document.

For more information regarding the integration using HR mini master, download the documents from the Employee Integration: S/4HANA on-premise with Employee Central (IH): Employee Integration: S/4HANA on-premise with Employee Central (IH).

Download the documents listed under Configuration:

- SuccessFactors: Integration of Employee Central and SAP S/4HANA (CSP)
- Integration of Employee Central to SAP S/4HANA(Employee, Org Data) with HCI (DSN)
- Integration of SAP S/4HANA to Employee Central (Cost Center Data) with HCI (DSI)

Full Implementation

If you want to replicate employee data to use the full scope of integration, (for example, payroll) you can refer to the following documents for detailed information:

- Employee data replication
  Refer to the SAP help portal under Enterprise Management > SAP S/4HANA > SAP S/4HANA, on-premise edition > Additional Information > Integration Information > Replicating Employee Master Data from Employee Central to SAP S/4HANA Using SAP HANA Cloud Integration as the Middleware

- Organizational data replication
  Refer to the SAP help portal under Enterprise Management > SAP S/4HANA > SAP S/4HANA, on-premise edition > Additional Information > Integration Information > Replicating Organizational Data from Employee Central to SAP S/4HANA HR Using SAP HANA Cloud Integration as the Middleware

- Cost center data replication
  Refer to the SAP help portal under Enterprise Management > SAP S/4HANA > SAP S/4HANA, on-premise edition > Additional Information > Integration Information > Replicating Cost Centers from SAP S/4HANA to Employee Central Using SAP HANA Cloud Integration as the Middleware
Employee-Business Partner Synchronization

Execute the employee synchronization after employee replication. For more details, refer to section Employee-Business Partner Synchronization [page 61].

Notes

- The cost center and company code are owned by SAP S/4HANA Finance. The cost centers defined in financials need to replicate into SAP SuccessFactors Employee Central to enable the assignment of employee to the Cost Center, for example, during the Hiring Process. This integration is supported through HCI Middleware iFlow.
- Company Codes are not replicated and have to be manually created in SAP SuccessFactors Employee Central (SFSF EC) because the definition of Companies in SFSF EC requires some additional information.
- SAP SuccessFactors Employee Central is responsible for the employee administration including the organizational assignment of employees to a Cost Center. This employment information is replicated into SAP S/4HANA via HCI.
- The Inbound processing within SAP S/4HANA maps existing Users with the corresponding Employee, Business Partner, and Employment.

7.14.2.2 Running SAP ERP HCM on a separate instance, integrated via ALE with SAP S/4HANA

The purpose of this section is to enable the integration of employee data in the SAP S/4HANA system for running the employee-related processes in SAP S/4HANA. The HR master system is the SAP ERP HCM system, which is the source of the employee data.

For this integration, the Application Link Enabling (ALE) from the SAP ERP HCM system is reused and no specific changes required for SAP S/4HANA. This section describes the steps involved in ALE configuration.

Prerequisite

The Application Link Enabling (ALE) HR master data replication for employees is a 1:1 replication of the values. To ensure that the ALE replication works successfully both the systems must have the same HCM configuration.

Steps for Execution

ALE Configuration Steps

1. Create Users for ALE transfer in both receiving and sending systems.
   Create users in both systems. Provide the same user name and relevant authorizations in both systems. These user IDs are used to logon through the remote connection and to perform IDoc transfers.
Make the necessary Customizing settings under **IDOC Interface/ Application Link Enabling > Basic Settings > Logical Systems**.

2. Make entries in **ALE: Original System Active for HR Data**.
   1. Call up transaction **SALE** in the SAP ERP HCM (SSP Client 105) system.
   2. In Customizing, go to **IDOC Interface/ Application Link Enabling > Modelling and Implementing Business Processes > Configure Predefined ALE Business Processes > Human Resources > Master Data Distribution > Distributed HR Master Data**.
   3. Choose **ALE: Original System Active for HR Data**.
   4. Make the following entries:

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Group</td>
<td>ALE</td>
</tr>
<tr>
<td>Sem.abbr.</td>
<td>REPPA</td>
</tr>
<tr>
<td>Value abbr.</td>
<td></td>
</tr>
</tbody>
</table>

5. Save your changes.
6. Choose **Continue**.

3. Define the logical systems.
Create logical systems for both the SAP ERP HCM system and the SAP S/4HANA, on-premise edition system if system management has not yet done so.
1. Call up transaction **SALE** in the SAP ERP HCM (SSP Client 105) system.
2. In Customizing, go to **IDOC Interface/ Application Link Enabling > Basic Settings > Logical Systems > Define Logical System**.
3. Choose **New Entries**.
4. Make the following entries:

<table>
<thead>
<tr>
<th>Logical System</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enter Logical Systems with the naming convention 'system name'+‘CLNT’+client no, for example, SSPCLNT105 for the sending system.</td>
<td>Enter a name to identify your SAP ERP HCM system.</td>
</tr>
<tr>
<td>Enter Logical Systems with naming convention 'system name'+‘CLNT’+client no, for example, SEDCLNT800 for the receiving system.</td>
<td>Enter a name to identify your S/4HANA, on-premise edition system.</td>
</tr>
</tbody>
</table>

**Note**
The distribution of data between systems requires that each system in the network has a unique identification. The logical system is used for this purpose.
5. Save your entries and choose Continue.
6. In the SAP S/4HANA, on-premise edition system (SED client 800) repeat steps 1 through 5 to create the logical systems for the Sending and Receiving system (for example, SEDCLNT800 and SSPCLNT05) if system management has not yet done so.

4. Assign the logical system to the client.
Assign the logical system for SAP ERP HCM system and the SAP S/4HANA, on-premise edition system to the corresponding client if system management has not yet done so.
1. Call up transaction SALE in the SAP ERP HCM (SSP Client 105) system.
2. In Customizing, go to IDOC Interface/ Application Link Enabling Basic Settings Logical Systems Define Logical System.
3. Search for the client you are currently logged in on (in this example 105) and choose the entry to display the details.
4. Check the following entry:

<table>
<thead>
<tr>
<th>Table 17:</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Field Name</strong></td>
</tr>
<tr>
<td>Logical System</td>
</tr>
</tbody>
</table>
5. Save your entry and choose Continue.
6. In the SAP S/4HANA, on-premise edition system (SED client 800): repeat steps 1 through 5 and check the logical system for the SAP S/4HANA, on-premise edition system/client (for example SEDCLNT800).

5. Create RFC connections.
1. Call up transaction SM59 in the SAP ERP HCM system (SSP Client 105).
2. Choose Create in the Configuration of RFC Connections view.
3. Make the following entries in the RFC Destination view:

<table>
<thead>
<tr>
<th>Table 18:</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Tabs</strong></td>
</tr>
<tr>
<td>----------</td>
</tr>
<tr>
<td>RFC Destination</td>
</tr>
<tr>
<td>Connection Type</td>
</tr>
<tr>
<td>Description</td>
</tr>
<tr>
<td>Technical Settings</td>
</tr>
<tr>
<td>Target Host</td>
</tr>
<tr>
<td>Tabs</td>
</tr>
<tr>
<td>-----------------------------</td>
</tr>
<tr>
<td>Logon &amp; Security Tab</td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td>Special Options Tab</td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
</tbody>
</table>

4. Save your changes.

5. Choose Remote Logon to test the RFC.

6. In the SAP S/4HANA, on-premise edition system (SED client 800): repeat steps 1 through 5 and create an ABAP connection SSPCLNT105 pointing to the SAP ERP HCM system giving logon credentials to client 105.

6. Maintain the distribution model.

The distribution model is created in the original system (sending system) and then distributed to other systems.

You can create a distribution model using the following steps:

1. Call up transaction BD64, in the SAP ERP HCM system (SSP client 105).
2. Choose Create Model view (CTRL + F4) in the Distribution Model view (in change mode).
3. In the Create Model View dialog box, enter a short text (for example, SAP HCM to SAP S/4) and a technical name (for example, <ZSSP_SED>).
4. Choose Continue and save your entries.
5. Select the newly created model and choose Add Message Type.
6. In the **Add Message Type** dialog box, enter the logical system of the SAP ERP HCM system in the **Sender** field (SSPCLNT105) and the logical system of the SAP S/4HANA, on-premise edition system in the **Receiver** field (SEDCLNT800). As message type, select **HRMD_A**.

7. Expand the model view and double-click **No filter set**.

8. Select **Create Filter Group** in the **Change Filter** view and restrict the replication to the required objects.

Table 19:

<table>
<thead>
<tr>
<th>Field name</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type of related objects</td>
<td>CP</td>
</tr>
<tr>
<td></td>
<td>P</td>
</tr>
<tr>
<td>Infotype</td>
<td>0000</td>
</tr>
<tr>
<td></td>
<td>0001</td>
</tr>
<tr>
<td></td>
<td>0002</td>
</tr>
<tr>
<td></td>
<td>0003</td>
</tr>
<tr>
<td></td>
<td>0006</td>
</tr>
<tr>
<td></td>
<td>0007</td>
</tr>
<tr>
<td></td>
<td>0009</td>
</tr>
<tr>
<td></td>
<td>0105</td>
</tr>
<tr>
<td></td>
<td>1000</td>
</tr>
<tr>
<td></td>
<td>1001</td>
</tr>
<tr>
<td>Object Type</td>
<td>CP</td>
</tr>
<tr>
<td></td>
<td>P</td>
</tr>
</tbody>
</table>

9. Choose **Enter**.

10. Save your entry.

11. Select the model view that you have created and go to **Environment** ➤ **Generate Partner Profiles**.

12. Select **Transfer IDOC Immediately** and **Trigger Immediately** in the **Generate Partner Profile** view.

13. Choose **Execute**. Go back to the main view.

   If it has been executed successfully, a green list is displayed.

14. Select the model view again and choose **Edit** ➤ **Model view** ➤ **Distribute**.

15. Choose **Continue**.

   A list is displayed with a message to inform you that the model view has been successfully distributed.

7. **Activate the change pointer.**

1. Call up transaction **SALE** in the SAP ERP HCM (SSP Client 105) system.

2. In Customizing, go to **IDOC Interface/ Application Link Enabling** ➤ **Modelling and Implementing Business Process** ➤ **Master Data Distribution** ➤ **Replication of Modified Data** ➤ **Activate Change Pointers for Message Types**.

3. In the change view **Activate Change pointers for Message Type**, verify that the activation is set for message type **HRMD_A**.
8. Maintain the port.
   1. Call up transaction `WE21` in the SAP ERP HCM (SSP Client 105) system. Alternatively, you can go to Customizing under `SAP Menu > Tools > ALE > ALE Administration > Runtime Settings > Port Maintenance.`
   2. Select `Transactional RFC` in the navigation panel of the `Ports in IDOC processing` view.
   3. Choose `Create`.
   4. In the `Ports in IDOC processing` view, select `own port name` and enter a technical name, for example `<SEDCLNT800>`.
   5. Choose `Enter`.
   6. Make the following entries on the `Creating a tRFC port` view:

<table>
<thead>
<tr>
<th>Field name</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Description</td>
<td>Enter a description for your port name.</td>
</tr>
<tr>
<td>Version</td>
<td></td>
</tr>
<tr>
<td>IDoc record types SAP Release 4.x</td>
<td>X</td>
</tr>
<tr>
<td>RFC destination</td>
<td>Enter the technical name of your RFC destination for the receiving SAP S/4HANA, on-premise edition system, for example, SEDCLNT800.</td>
</tr>
</tbody>
</table>

   7. Save your entries.

9. Create partner profiles
   1. Call up transaction `WE20` in the SAP ERP HCM (SSP Client 105) system.
   2. Select `Partner Type LS` in the navigation panel of the `Partner profiles` view.
   3. Choose `Create` and make the following entries:

<table>
<thead>
<tr>
<th>Field name</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Partner No.</td>
<td>Enter the ID for your partner no. Your ALE partner is an SAP system that is addressed by your system (using RFC), in this case the SAP S/4HANA, on-premise edition system, for example, SEDCLNT800</td>
</tr>
<tr>
<td>Partn. Type</td>
<td>LS</td>
</tr>
</tbody>
</table>

   4. On the `Post processing: permitted agent` tab, specify the job (person or group of people) to be notified if processing errors occur.
   5. In the `Outbound parmtrs.` section, choose `Create outbound Parameter`. 
6. In the **Partner profiles: Outbound parameters** view, make the following entries:

<table>
<thead>
<tr>
<th>Field name</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Message Type</td>
<td>HRMD_A</td>
</tr>
<tr>
<td>Receiver Port</td>
<td>Enter the technical Name of the created port, for example, SEDCLNT800</td>
</tr>
<tr>
<td>Pack. Size</td>
<td>For example, 100 (for the first testing use 1)</td>
</tr>
<tr>
<td>Output Mode</td>
<td></td>
</tr>
<tr>
<td>Transfer IDoc Immed.</td>
<td>X</td>
</tr>
<tr>
<td>Basic Type</td>
<td>HRMD_A07</td>
</tr>
<tr>
<td>Cancel Processing After Syntax Error</td>
<td>X</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Message Type</td>
<td>SYNCH</td>
</tr>
<tr>
<td>Receiver Port</td>
<td>Enter the technical Name of the created port, for example, SEDCLNT800</td>
</tr>
<tr>
<td>Pack. Size</td>
<td>For example, 100</td>
</tr>
<tr>
<td>Output Mode</td>
<td></td>
</tr>
<tr>
<td>Transfer IDoc Immed.</td>
<td>X</td>
</tr>
<tr>
<td>Basic Type</td>
<td>SYNCHRON</td>
</tr>
<tr>
<td>Cancel Processing After Syntax Error</td>
<td>X</td>
</tr>
</tbody>
</table>

7. Save your entries.
8. Call up transaction `WE20` in the SAP S/4HANA, on-premise edition system (SED client 800).
9. Select **Partner Type LS** in the navigation panel of the **Partner profiles** view.
10. Choose **Create** and make the following entries:

<table>
<thead>
<tr>
<th>Field name</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Partner No.</td>
<td>Enter the ID for your partner no. Your ALE partner is an SAP system that is addressed by your system (using RFC), in this case the SAP ERP HCM system, for example SSPCLNT105</td>
</tr>
</tbody>
</table>
11. On the Post processing: permitted agent tab, specify the job (person or group of people) to be notified if processing errors occur.
12. In the Inbound params. section, choose Create inbound Parameter.
13. In the Partner profiles: Inbound parameters view in the Inbound options section, make the following entries:

<table>
<thead>
<tr>
<th>Field name</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Partn. Type</td>
<td>LS</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Field name</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Message Type</td>
<td>HRMD_A</td>
</tr>
<tr>
<td>Process Code</td>
<td>HRMD</td>
</tr>
<tr>
<td>Cancel Processing After Syntax Error</td>
<td>X</td>
</tr>
<tr>
<td>Processing by Function Module</td>
<td></td>
</tr>
<tr>
<td>Trigger Immediately</td>
<td>X</td>
</tr>
</tbody>
</table>

14. Save your entries.

**Note**

By default, in the receiving system IDocs are grouped together and received.

10. Run the initial distribution.

1. Call up transaction PFAL in the SAP ERP HCM system (SSP client 105)
2. On the HR: ALE Distribution of HR Master Data view, specify the required Object Type, Object ID, and so on, before executing and choose the following option:

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Insert (complete distribution: delete in target system, re-create)</td>
<td>X</td>
</tr>
</tbody>
</table>

3. Choose Execute.

11. Check IDocs.

In the receiving system (SED client 800) check the inbound IDocs (transaction: WE02/WE05). Some inbound IDocs may have errors. This may be due to some HR specific Data and configuration issues in the receiving system. In this case, contact an HR functional consultant.

12. Define a background job for delta distribution.

To schedule the background job in the sending system (SSP client 105), create a variant of ABAP program RBDMIDOC.
1. Create a variant.

1. Go to transaction `SE38` in the SAP ERP HCM (SSP Client 105) system. Alternatively, you can go to customizing under `SAP Menu > Tools > ABAP Workbench Development > ABAP Editor`.

2. On the `ABAP Editor: Initial Screen`, enter `RBDMIDOC` in the `Program` field.

3. Choose `Execute`.

4. In the `Creating IDoc Type from Change Pointers` view, enter the following value:

   Table 27:
   
<table>
<thead>
<tr>
<th>Field Name</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Message Type</td>
<td>HRMD_A</td>
</tr>
</tbody>
</table>

5. Choose `Save as Variant` to create a new variant.

6. On the `Variant Attributes` view, enter the following values:

   Table 28:
   
<table>
<thead>
<tr>
<th>Field Name</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Variant Name</td>
<td>YK_HRMD_A</td>
</tr>
<tr>
<td>Description</td>
<td>Enter a description for the variant</td>
</tr>
</tbody>
</table>

7. Save your entries.

   Note
   
   A system notification confirms the creation.

2. Schedule a job

1. Call up transaction `SM36` in the SAP ERP HCM (SSP Client 105) system. Alternatively, you can go to Customizing under `SAP Menu > System > Services > Jobs > Define Job`.

2. In the `Define Background Job` view, choose `Define Job using Wizard` (Ctrl+F1).

3. In the `Create a Job` dialog box, choose `Continue`.

4. In the `General Job Information` dialog box, make the following entries:

   Table 29:
   
<table>
<thead>
<tr>
<th>Field Name</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Job Name</td>
<td>YK_ALE_DELTA_HRMD_A</td>
</tr>
<tr>
<td>Job Class</td>
<td>C - Low priority</td>
</tr>
<tr>
<td>Job Status</td>
<td>Scheduled</td>
</tr>
</tbody>
</table>
5. Choose *Continue*.

6. In the **Job-Definition: Job step** dialog box, select **ABAP program step** and choose *Continue*.

7. In the **ABAP program step** dialog box, make the following entries:

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>ABAP program name</td>
<td>RBDMIDOC</td>
</tr>
<tr>
<td>Variant</td>
<td>YK_HRMD_A</td>
</tr>
<tr>
<td>Execution language</td>
<td>EN</td>
</tr>
</tbody>
</table>

8. Choose *Continue*.

9. In the **Multi-step option** dialog box, choose *Continue*.

10. In the **Job Definition: Start conditions** view, choose *Immediately*. Choose *Continue*.

11. In the **Def. of start immediately** dialog box, select the **Period** checkbox in the **Periodic jobs** section and choose *Continue*.

12. In the **Period definition** dialog box, choose *None of the Above*.

13. Choose *Other Periods*.

14. In the **Other Period** dialog box, schedule the service for a convenient time interval.

15. Choose *Create*.

16. Choose *Continue*.

17. In the **Set job** dialog box, choose *Complete* to finish the setup.

### Employee-Business Partner Synchronization

After employee replication, you must execute the employee synchronization. For more details, refer to section Employee-Business Partner Synchronization [page 61].

#### 7.14.2.3 Running SAP ERP HCM on same instance with SAP S/4HANA (codeployed)

The purpose of this section is to enable you to run SAP ERP HCM on the same instance with SAP S/4HANA. All the required steps to implement this integration are listed in the Customizing documentation under **Personnel Management** ➔ **SAP S/4HANA for Human Resources** ➔ **Synchronization of Business Partner for SAP HCM Employee Role**

All the existing employees have to be synchronized during business downtime. For more information, refer to the section Employee-Business Partner Synchronization [page 61].
Prerequisites

You must have an existing SAP ERP HCM solution as your HR master data system.

Notes

Report like HRALXSYNC (report)

You cannot use this sync report for employee synchronization in SAP S/4HANA. For any other (organizational unit) object synchronization, you can use this report.

Transaction PRAA

This transaction was used for employee vendor creation in the SAP ERP system for travel expenses. You cannot create employee vendors using this transaction and it is no longer valid in the SAP S/4HANA system.

7.14.3 Conversion from SAP ERP to SAP S/4HANA

This section is relevant only if you are converting from SAP ERP to SAP S/4HANA.

There are 2 processes involved in the conversion to SAP S/4HANA:

- CVI Conversion in the SAP ERP system
  This can be considered as a pre-conversion process which has to be performed in the SAP ERP system. This is relevant only if you are using employee vendor in the SAP ERP system. For more information about the CVI conversion process, refer to the SAP Note 2265093.
- Employee-BP Synchronization in the SAP S/4HANA System
  This is the post conversion process that has to be performed in the SAP S/4HANA system during business downtime. For more information, refer to section Employee-Business Partner Synchronization [page 61].

Note

Employee synchronization report handles the linking the Vendor to BP for single assignment scenario only. Refer FAQ note 2409229 for more information.

BP Synchronization Data Models for SAP ERP and SAP S/4HANA

Source Data Model (SAP ERP)
In the above data model, each central person can have a single or multiple PERNR associated with it. A vendor can be created for a PERNR. This is an optional step. In case of concurrent employment, multiple vendors can be created for a PERNR.

**Example:** If a record 100(CP) exists and a PERNR 500 (P) exists for the CP, a business partner BP1 is created for this CP. You can create vendors for this PERNR. For example, V1, V2. Another business partner is created for each of these associated vendors, for example, BPV1, BPV2 (if CVI is active during Vendor creation). Hence in the SAP ERP model, each CP can have 2 or more BP associated, depending on the number of vendors and configuration.

**Target Data Model (SAP S/4HANA)**
In the new data model, each Central Person is associated with a PERNR. If a BP is already associated with the CP, then this BP is linked to the user identity.

If no BP exists then the system checks for associated vendor. If a vendor exists then the BP (of category Person) associated with the vendor is linked with the CP and user identity. If no vendor exists, a vendor is created for PERNR if Permanent address (subtype 1 of infotype 6) and Payment (Main Bank or Travel Expense – subtype 0 or 2 of Infotype 9) is assigned for the employee. This is a mandatory step. Vendor will be created in case of single assignment scenario only.

If Vendor exists and linked with PERNR in ERP but there is no BP created (as in 1709 CVI conversion is skipped for the Vendors which are linked with Employee (like LFB1-PERNR) ), if such vendor exist, it will be linked with the BP and Employee.

If Employee-BP (HRP1001 CP-P and CP-BP relationship exist) also Vendor-BP (of type Person category) exist, then it is an error scenario, as which BP to be linked with Employee and Vendor is not known (as it depends on business scenario). In such scenario, customer need to remove one of the BP or relationships.

From 1709, if Vendor has BP of type Organization category, then it will NOT be deleted, but an error message is displayed to that BP of type Organization category is found. Customer can remove the BP or retain it as standalone BP in case it is still consumed in business processes.

**Example:** If a record 100(CP) exists, then a PERNR 500 (P) is associated with it. After the integration, if a BP1 is found that is associated with this CP, then this data is used for synchronization. The user identity is also linked to this BP1. If vendors are associated with this PERNR, for example, V1. Vendor has BPV1. In case, the BP1 already exists for the CP 100, then Error is displayed that multiple BPs found. In case, no BP exists for CP 100, then the Vendor BP, BPV1 is used for synchronization in case BPV1 is of category Person. Otherwise this BP will reported in Error message and new BP of category Person will be created and linked with the objects.
Note
As of now, in case an employee has multiple assignment and vendors in SAP ERP, this scenario is not supported in the synchronization report after migration to SAP S/4HANA. This must be handled manually, see Simplication Note 2340095.

Differences Between SAP ERP and SAP S/4HANA Data model

- **Synchronization**
  This process was optional and base on switch setting in the SAP ERP system, but it is a mandatory step in the SAP S/4HANA system.

- **Vendor and BP relation**
  An employee could have multiple vendors and BPs associated with his PERNR in the SAP ERP system. In SAP S/4HANA a single BP and Vendor is created for an employee. Multiple company segments (LFB1) based on employment (Company Code changes) is still relevant in both systems.

- **User Identity**
  - In SAP S/4HANA, User identity is connected to BP only it is maintained in Infotype 105.
  - In SAP ERP system, workplace address was modeled using the BP (Organization) -> BP (Employee) relationship. In SAP S/4HANA, Workplace Address information (business phone, e-mail) is stored in workplace address connected to BP.

  **Note**
  You can only maintain one workplace address for an employee.

  - In SAP S/4HANA, if a BP and user relationship exists then it’s always modeled as 1:1. Hence, it is recommended to use only single user (SY-UNAME) across all employments (P) of employee(CP).

- **Address Types and Identification**
  In SAP ERP, employees were linked BP through Personnel Number field in BP. In SAP S/4HANA, New Address types (HCM001, private address of employee) and New Identification (HCM001) are created for BP employee.

Conversion Scenarios for Employee Vendors in SAP S/4HANA

In SAP S/4HANA, each employee will have a corresponding business partner and vendor for the employee. So any vendors created manually in the SAP ERP system (using the transaction PRAA or other transactions) have to be migrated consistently into the SAP S/4HANA system. The following scenarios might exist:

- **No business partner or vendor exists for an employee**
  In this case both objects have to be generated (LFB1-PERNR is to be filled).

  **Note**
  Vendor is created for PERNR if Permanent address (subtype 1 of infotype 6) and Payment (Main Bank or Travel Expense – subtype 0 or 2 of Infotype 9) is assigned for the employee. Vendor will be created in case of single assignment scenario only.

- **Only a business partner exists**
  In this case the business partner has to be enriched by the vendor role and the vendor has to be created in case Vendor and payment information is maintained for the employee (LFB1-PERNR as to be filled).
A vendor for an employee exists with LFB1-PERNR but is assigned to a different business partner of category Person than the business partner related to the Central Person of PERNR. This will be an error scenario, customer need to correct one of the BusinessPartner and need to adjust the relationships.

The first two scenarios are transformed using the Employee-Business partner Synchronization. This is triggered by any change made on Employee side effecting integration relevant infotypes (0, 1, 2, 6, 9, 105). In addition, a report /SHCM/RH_SYNC_BUPA_FROM_EMPL scheduled in batch every 24 hours transfers time-dependent employee data into the business partner persistency.

The other scenarios are also now handled using the /SHCM/RH_SYNC_BUPA_FROM_EMPL report:

- Find Vendor with LFB1-PERNR that have NOT a related BP in link table as CVI conversion is not sun for the Employee-Vendors
  - Such Vendor is linked with Employee-BP
  - Employee-BP is enriched with vendor role

### 7.14.4 Employee-Business Partner Synchronization

The following steps enable you to synchronize the business partners. This synchronization is a mandatory activity for SAP S/4HANA to make sure the follow-up activities and the CDS views work.

For more information, you can also refer to the Customizing under [Personnel Management > SAP S/4HANA for Human Resources > Synchronization of Business Partner for SAP HCM Employee Role](#).

**Note**

- The following activity must be set during the initial business downtime before production starts.
- In case of large volume of employee data, standard report /SHCM/RH_SYNC_BUPA_FROM_EMPL will take lot of time to synchronize the employees. You could try the recommendations in FAQ note for 2409229 regarding process the employees in parallel jobs.

### Notes (SAP S/4HANA)

**HRALXSYNC (report)**

You cannot use this sync report for employee synchronization in SAP S/4HANA. For any other (organizational unit) object synchronization, you can use this report.

**Transaction PRAA**

This transaction was used for employee vendor creation in the SAP ERP system for travel expenses. You cannot create employee vendors using this transaction and it is no longer valid in the SAP S/4HANA system.
Prerequisites

- Set the following switches in the table T77S0:
  - Set HRALX PBPON to **OFF**. Integration Employee or BP Activated
  - HRALX PNUMB Business Partner Number Assignment (Employee) and HRALX PSUBG Business Partner Subgroup (Employees): use this to provide to different number range to BP. Refer to the T77S0 switch documentation.
  - PLOGI PLOGI Integration Plan Version / Active Plan Version: determines the active integrated plan version.

**Note**
All other switches under HRALX are not relevant in SAP S/4HANA for Employee BP Synchronization.

- Set up the BP customizing for CVI and vendor account
  For more information regarding the BP customizing, see **Requirement** section in the Customizing document under Personnelf Management > SAP S/4HANA for Human Resources > Synchronization of Business Partner for SAP HCM Employee Role.

### 7.14.4.1 SAP S/4HANA BUPA Synchronization Report

You can use the BUPA Synchronization Report (technical name: /SHCM/RH_SYNC_BUPA_FROM_EMPL) to synchronize employee data stored in HCM master data persistence (infotypes) with the business partner and vendor.

For more information, you can also refer to the Customizing under Personnelf Management > SAP S/4HANA for Human Resources > Synchronization of Business Partner for SAP HCM Employee Role.

Data is synchronized if employee data is created or changed in the following ways:

- **Inbound processing from Employee Central**
  The synchronization is triggered using the following BADi implementations:
  - HRPAD00INFTYDB: /SHCM/TRIGGER_BUPA_SYNCHRPA0INFTY
  - /SHCM/TRIG_BUPA_SYNC

- **Inbound processing using ALE**
  The synchronization is triggered using the following BADi implementation:
  - HRALE00INBOUND_IDOC: /SHCM/BUPA_SYNC_TRIG

- **Personnel master data maintenance (for example, transaction PA30)**
  The synchronization is triggered using the following BADi implementations:
  - HRPAD00INFTYDB: /SHCM/TRIGGER_BUPA_SYNC
  - HRPAD00INFTY: /SHCM/TRIG_BUPA_SYNC

**Note**
- HCM master data is time-independent, but some business partner data is not. Therefore, schedule this report to run on a daily basis to update the business partner and receive up-to-date employee data. You can customize and use the standard job defined in SJOBREPO.
- If a synchronization is unsuccessful, all the employee data is updated in the next synchronization run.
Field mapping used for employee synchronization

BP Fields:
- BP Grouping: If BP grouping is created with BPEE then it will be considered for BP creation otherwise:
  1. In case switch HRALX PNUMB is 1 and internal number range scenario, then set true value to XINST (Standard Grouping for Internal Number Assignment) for the BP Grouping, that is, BP group of internal number range type and field XINST is set is considered.
  2. In case HRALX PNUMB is 2 or 3 then BP grouping should be same as switch HRALX PSUBG in T77S0.
- BP category: 1 (Person)
- Identification Category:
  - Employee: HCM001
  - Freelancer - HCM031 (SAP S/4HANA 1610 release)
  - Service Performer - HCM030 (SAP S/4HANA 1610 release)
- Identification ID: minimum PERNR in case of CE or single assignment the same PERNR or 105-ECUS in case of SAP SuccessFactors Integration is used.
- Roles:
  - Employee: BUP003, 1511- till SP1: FLVN01, 1511 SP2 & higher releases FLVN00.
  - Freelancer: BBP010, FLVN00, FLVN01 (as of SAP S/4HANA 1610 release)
  - Service Performer: BBP005 (as of SAP S/4HANA 1610 release)

Table 31:

<table>
<thead>
<tr>
<th>Field description</th>
<th>Infotype</th>
<th>Field Name</th>
<th>Comments</th>
<th>BP Field name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Employee</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>First Name</td>
<td>2</td>
<td>VORNA</td>
<td></td>
<td>person-firstname</td>
</tr>
<tr>
<td>Last Name</td>
<td>2</td>
<td>NACHN</td>
<td></td>
<td>person-lastname</td>
</tr>
<tr>
<td>Middle Name</td>
<td>2</td>
<td>MIDNM</td>
<td></td>
<td>middlename</td>
</tr>
<tr>
<td>Second Name</td>
<td>2</td>
<td>NACH2</td>
<td></td>
<td>secondname</td>
</tr>
<tr>
<td>Initials</td>
<td>2</td>
<td>INITS</td>
<td></td>
<td>initials</td>
</tr>
<tr>
<td>Title</td>
<td>2</td>
<td>TITEL</td>
<td></td>
<td>title_aca1</td>
</tr>
<tr>
<td>Gender</td>
<td>2</td>
<td>GESCH</td>
<td></td>
<td>person-sex</td>
</tr>
<tr>
<td>Preferred Language</td>
<td>2</td>
<td>SPRSL</td>
<td></td>
<td>correspondlangua-geiso</td>
</tr>
<tr>
<td>Nationality</td>
<td>2</td>
<td>natio</td>
<td></td>
<td>nationality</td>
</tr>
<tr>
<td>Date of Birth</td>
<td>2</td>
<td>gbdat</td>
<td></td>
<td>birthdate</td>
</tr>
<tr>
<td>Field Description</td>
<td>Infotype</td>
<td>Field Name</td>
<td>Comments</td>
<td>BP Field Name</td>
</tr>
<tr>
<td>-------------------</td>
<td>----------</td>
<td>------------</td>
<td>----------</td>
<td>---------------</td>
</tr>
<tr>
<td>Address</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>From Date</td>
<td>6</td>
<td>BEGDA</td>
<td></td>
<td>validfromdate</td>
</tr>
<tr>
<td>End Date</td>
<td>6</td>
<td>ENDDA</td>
<td></td>
<td>country</td>
</tr>
<tr>
<td>Country</td>
<td>6</td>
<td>LAND1</td>
<td></td>
<td>region</td>
</tr>
<tr>
<td>Region</td>
<td>6</td>
<td>STATE</td>
<td></td>
<td>city</td>
</tr>
<tr>
<td>City</td>
<td>6</td>
<td>ORTO1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>District</td>
<td>6</td>
<td>ORTO2</td>
<td></td>
<td>district</td>
</tr>
<tr>
<td>Postal Code</td>
<td>6</td>
<td>PSTLZ</td>
<td></td>
<td>postl_cod1</td>
</tr>
<tr>
<td>Street</td>
<td>6</td>
<td>STRAS</td>
<td></td>
<td>street</td>
</tr>
<tr>
<td></td>
<td>6</td>
<td>ADR03</td>
<td></td>
<td>str_suppl1</td>
</tr>
<tr>
<td></td>
<td>6</td>
<td>ADR04</td>
<td></td>
<td></td>
</tr>
<tr>
<td>House Number</td>
<td>6</td>
<td>HSNMR</td>
<td></td>
<td>house_no</td>
</tr>
<tr>
<td>telephone</td>
<td>6</td>
<td>TLNR</td>
<td></td>
<td>telephone</td>
</tr>
<tr>
<td>Payment</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Account Holder</td>
<td>1</td>
<td>ENAME</td>
<td></td>
<td>accountholder</td>
</tr>
<tr>
<td>Name</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Bank</td>
<td>9</td>
<td>BANKS</td>
<td></td>
<td>bank_ctry</td>
</tr>
<tr>
<td>Bank Account</td>
<td>9</td>
<td>BANKN</td>
<td></td>
<td>ctrl_key</td>
</tr>
<tr>
<td>Control Key</td>
<td>9</td>
<td>BKONT</td>
<td></td>
<td>bank_key</td>
</tr>
<tr>
<td>Bank Key</td>
<td>9</td>
<td>BANKL</td>
<td></td>
<td>iban</td>
</tr>
<tr>
<td>IBAN No.</td>
<td>9</td>
<td>IBAN</td>
<td></td>
<td>bankdetailvali-</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>dfrom</td>
</tr>
<tr>
<td>Valid From</td>
<td>9</td>
<td>BEGDA</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Valid To</td>
<td>9</td>
<td>ENDDA</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Vendor Company</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Code</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>BUKRS</td>
<td>1</td>
<td>BUKRS</td>
<td></td>
<td>key-bukrs</td>
</tr>
<tr>
<td>ZLSCH</td>
<td>9</td>
<td>ZLSCH</td>
<td></td>
<td>zwels</td>
</tr>
<tr>
<td>PERNR</td>
<td>1</td>
<td>PERNR</td>
<td></td>
<td>perrn</td>
</tr>
<tr>
<td>Field description</td>
<td>Infotype</td>
<td>Field Name</td>
<td>Comments</td>
<td>BP Field name</td>
</tr>
<tr>
<td>-------------------</td>
<td>----------</td>
<td>------------</td>
<td>----------</td>
<td>---------------</td>
</tr>
<tr>
<td>Reconciliation account</td>
<td>(see comment)</td>
<td>Read from /SHCM/RECON based on Employee’s company code (IT0001-BUKRS)</td>
<td>akont</td>
<td></td>
</tr>
</tbody>
</table>

### Field mapping for Workplace Address:

- In case User (infotype 105, subtype 0001) is maintained for the Employee. During employee synchronization, if the user is of type 00 (user’s old Type 3 Address, that is, USR21-IDADTYPE: 00), then the existing workplace address data is retained and only the following information is updated or overwritten if present in the infotypes.
- In case no user is maintained then following information is updated as workplace address.

#### Table 32:

<table>
<thead>
<tr>
<th>Field Description</th>
<th>Infotype</th>
<th>Field Name</th>
<th>Comments</th>
<th>BP Field Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Department</td>
<td>1</td>
<td>ORGEH</td>
<td></td>
<td>Department</td>
</tr>
<tr>
<td>Function</td>
<td>1</td>
<td>PLANS</td>
<td></td>
<td>Function</td>
</tr>
<tr>
<td>Room Number</td>
<td>32</td>
<td>ZIMNR</td>
<td></td>
<td>Room Number</td>
</tr>
<tr>
<td>Building Number</td>
<td>32</td>
<td>GEBNR</td>
<td></td>
<td>Building Code</td>
</tr>
<tr>
<td>Telephone</td>
<td>105</td>
<td></td>
<td>infotype 105, subtype 20</td>
<td>Telephone</td>
</tr>
<tr>
<td>Cell Phone</td>
<td>105</td>
<td></td>
<td>infotype 105, subtype CELL</td>
<td>Cell Phone</td>
</tr>
<tr>
<td>E-Mail Address</td>
<td>105</td>
<td></td>
<td>infotype 105, subtype 10</td>
<td>E-Mail Address</td>
</tr>
</tbody>
</table>

### 7.14.4.1.1 Authorizations

Human Resources uses the authorization concept provided by the SAP NetWeaver AS for ABAP or AS Java. Therefore, the recommendations and guidelines for authorizations as described in the SAP NetWeaver AS Security Guide ABAP and SAP NetWeaver AS Security Guide Java also apply.

The SAP NetWeaver authorization concept is based on assigning authorizations to users based on roles. For role maintenance, use the profile generator (transaction PFCG) on the AS ABAP and the User Management Engine’s user administration console on the AS Java.
### Standard Roles

The table below shows the standard roles that are used.

<table>
<thead>
<tr>
<th>Role</th>
<th>Front-end Role</th>
<th>Back-end Role</th>
<th>Both (Front-end + Back-end)</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SAP_BR_ADMINISTRATOR_HRINFO</td>
<td>Yes</td>
<td>-</td>
<td>-</td>
<td>Administrator App (For example, Monitoring Employee Synchronization)</td>
</tr>
<tr>
<td>SAP_COM_CSR_1001_OP</td>
<td>-</td>
<td>Yes</td>
<td>-</td>
<td>Monitoring Employee Synchronization App</td>
</tr>
</tbody>
</table>

### Standard Authorization Objects

The table below shows the security-relevant authorization objects that are used.

<table>
<thead>
<tr>
<th>Authorization Object</th>
<th>Field</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>B_BUPA_RLT (Business Partner: BP Roles)</td>
<td>ACTVT</td>
<td></td>
<td>Activity</td>
</tr>
<tr>
<td></td>
<td>RLYTP</td>
<td></td>
<td>BP Role</td>
</tr>
<tr>
<td>F_LFA1_APP (Vendor: Application Authorization)</td>
<td>ACTVT</td>
<td></td>
<td>Activity</td>
</tr>
<tr>
<td></td>
<td>APPKZ</td>
<td></td>
<td>Customer and Vendor Master Data Application Authorization</td>
</tr>
<tr>
<td>F_LFA1_BUK (Vendor: Authorization for Company Codes)</td>
<td>BUKRS</td>
<td></td>
<td>Company Code</td>
</tr>
<tr>
<td></td>
<td>ACTVT</td>
<td></td>
<td>Activity</td>
</tr>
</tbody>
</table>
### 7.14.4.2 Design Constraints

#### Workplace Address Data

If the infotype 105, system User Name (SY-Uname) 0001 is maintained for the employee and workplace address is synchronized then User will be converted to type 04 (Identity with Workplace Address). If workplace address information is not present or synchronized then user is converted to 02 (User Account with BP Person).
In case User assignment is removed (infotype 105, subtype 0001 is removed for the employee) then after the employee synchronization report execution, User will be converted to type 01 (Technical User i.e. USR21-IDADTYPE : 01).

In case User is converted to 02 or 04-IDADTYPE then Workplace address or address section will not be editable in User Administration transaction like SU01.

**Support of Other employment scenarios in Employee-Business Partner Synchronization**

The synchronization is able to handle employees with single employments and single vendor assignment only, other scenarios are not supported (like Concurrent Employment, Global Employment, Country Transfer).

### 7.14.5 FAQ

For more information about the FAQs, refer to the SAP Note [2409229](https://support.sap.com).

### 7.14.6 Related Notes

- [2265093](https://support.sap.com) - S4TWL - Business Partner Approach
- [2383837](https://support.sap.com) - S4TWL - SAP Learning Solution not available in Compatibility Mode
- [2340095](https://support.sap.com) - S4TWL - Conversion of Employees to Business Partners
- [2273108](https://support.sap.com) - S4TWL - General HCM Approach within SAP S/4HANA
- [2383888](https://support.sap.com) - S4TWL - SAP E-Recruiting not available in Compatibility Mode
- [2383879](https://support.sap.com) - S4TWL - Java-based ESS and MSS not available in Compatibility Mode
- [2393462](https://support.sap.com) - All changes in 1610
- [2241838](https://support.sap.com) - Limitations to PRAA transaction in S/4HANA
- [2399801](https://support.sap.com) - Workplace Address synchronization corrections

### 7.15 Follow-Up Activities for the SAP S/4HANA Financial Closing cockpit
7.15.1 Setting Up the BI Content

This section includes information on how to set up the Business Intelligence (BI) content for the SAP S/4HANA Financial Closing cockpit. You can find the BI content at the following locations:

- **Other objects:** On the SAP Help Portal, search for BI Content. Open the latest version of the BI content (for example, BI Content 7.57). Under Application Help, open SAP Library. There, go to chapter SAP ERP Central Component ➔ Financials ➔ SAP Financials Closing cockpit.

**Prerequisites**

- The SAP ERP Central Component (ECC) system where the SAP S/4HANA is installed is connected as a source system. To achieve this, complete the following steps:
  1. Run transaction RSA1 on the SAP Business Warehouse (BW) system.
  2. Click Source Systems on the Modeling tab.
  3. Right-click a folder and choose Create from the context menu to add a new system.
- BI Content 7.57 for SAP NetWeaver 7.5 is installed on the BW system.

**Procedure**

**Configuring the BW System**

**Installing the BI Content**

To install the BI content for the SAP S/4HANA Financial Closing cockpit, complete the following steps:

1. Replicate the DataSources for the SAP S/4HANA Financial Closing cockpit from the source system to the BW system:
   1. Run transaction RSA1.
   2. Click DataSources on the Modeling tab.
   3. Choose the Replicate Tree Metadata pushbutton to get the list of the DataSources from the source system. If the list does not appear, run transaction RSA9 on the source system to enable the hierarchy.
   4. Right-click Financial Closing Cockpit and choose Replicate Metadata from the context menu. Choose As a DataSource when prompted for non-hierarchy DataSources and As a 3.x DataSource when prompted for hierarchy DataSources.
2. Activate the DataSources:
   1. Run transaction RSA1.
   2. Click DataSources on the Modeling tab.
   3. Double-click each DataSource under Financial Closing Cockpit and activate it. After a DataSource is activated, an entry Data Flow Upwards appears under it.
3. Install the BI content for the SAP S/4HANA Financial Closing cockpit:
   1. Run transaction RSA1.
   2. Click Object Types on the BI Content tab.
   3. Choose the Source System Assignment pushbutton and then select the source system in the dialog box that appears.
   4. Expand Query Elements Query and then double-click Select Objects.
   5. Select the queries for the Financial Closing cockpit. You find all the queries for the Financial Closing cockpit by entering 0FCC and then choosing the Find pushbutton.
   6. For each query, choose Grouping In Dataflow Before and Afterwards, and then choose Install.

Extracting Data from the BI Content

To extract data from the BI content you have installed, complete the following steps:

1. Create InfoPackage for each DataSource:
   1. Run transaction RSA1.
   2. Click InfoProvider on the Modeling tab.
   4. Right-click each DataSource and choose Create InfoPackage from the context menu.

2. Define data selection for each InfoPackage to extract data:
   1. Run transaction RSA1.
   2. Click InfoProvider on the Modeling tab.
   3. Double-click each DataSource.
   4. On the Data Selection tab, enter the parameters for data extraction.

3. Extract data:
   1. Run transaction RSA1.
   2. Click InfoProvider on the Modeling tab.
   3. Double-click each DataSource.
   4. On the Schedule tab, click Start to extract data.

4. Run Data Transfer Processes:
   1. Run transaction RSA1.
   2. Click InfoProvider on the Modeling tab.
   3. Double-click each Data Transfer Process.
   4. On the Execute tab, click Execute.

5. (Optional) Set up Process Chains for data extraction.

Configuring the ECC System (for Viewing the Reports via NWBC)

Configuring Roles
To configure roles, complete the following steps:

1. Run transaction PFCG.
2. Enter role SAP_FCC_MENU and choose the Change pushbutton.
3. On the User tab, add IDs for the users who shall view the reports via SAP NetWeaver Business Client (NWBC).

Changing the System Alias

To change the system alias, complete the following steps:

1. Run transaction LPD_CUST.
2. Double-click the line that specifies FCC as the role and FCC_REP as the instance.
3. Double-click each query and change the system alias to the one connected to the BW system.

7.16 Troubleshooting

Unable to Create New Clients

If you are unable to create new clients in transaction SCC4 or SM30 (table T000) because the New Entries button is missing, see SAP Note 2140167.
Important Disclaimers and Legal Information

Coding Samples

Any software coding and/or code lines / strings ("Code") included in this documentation are only examples and are not intended to be used in a productive system environment. The Code is only intended to better explain and visualize the syntax and phrasing rules of certain coding. SAP does not warrant the correctness and completeness of the Code given herein, and SAP shall not be liable for errors or damages caused by the usage of the Code, unless damages were caused by SAP intentionally or by SAP's gross negligence.

Gender-Neutral Language

As far as possible, SAP documentation is gender neutral. Depending on the context, the reader is addressed directly with "you", or a gender-neutral noun (such as "sales person" or "working days") is used. If when referring to members of both sexes, however, the third-person singular cannot be avoided or a gender-neutral noun does not exist, SAP reserves the right to use the masculine form of the noun and pronoun. This is to ensure that the documentation remains comprehensible.

Internet Hyperlinks

The SAP documentation may contain hyperlinks to the Internet. These hyperlinks are intended to serve as a hint about where to find related information. SAP does not warrant the availability and correctness of this related information or the ability of this information to serve a particular purpose. SAP shall not be liable for any damages caused by the use of related information unless damages have been caused by SAP’s gross negligence or willful misconduct. All links are categorized for transparency (see: https://help.sap.com/viewer/disclaimer).